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This issue is about one
thlng the importance of
a story. In animated films,
you can have great
characters, beautiful - —

scenery and amaZing Ig;glfizsi'?)?lzgﬁtlils?saa?l‘é:é?ng animation studios share
action sequences. But it their know-how on creating a job-grabbing portfolio.
won't connect with the audience unless | '
there’s a compelling story linking it all
together. Your art has to connect with the
viewer in more ways than just looking
pretty. Reading through Peter de Seve's
interview, Armand Serrano’s background
art workshop and Matt Jones’ storyboarding
advice, they all reveal how they go beyond
the pose or scene to make that connection

From back to front

and r eally bring the narrative home. How to make your background art the star of the
There’s also never been a better time to shoyv, with Disney artist Armand Serrano.

subscribe. We're giving away a copy of " - i

Rebelle, a top-rated natural-media painting >

program. We deliver to over 100 countries. - s

Turn to page 36 right now to sign up to -

this great deal before stocks run out!

N _‘
3 \ d

Claire Howlett, Editor Gouache and watercolour workshop
claire @imaginefx.com Bao Pham shares his wet-in-wet technique to create
gradients of colour in his beautiful paintings.

™ mail@imaginefx.com ' & Ik S Free gift
¥ @imaginefx s A WOI‘th $60!

f facebook.com/imaginefx ‘- o3 § | We're giving away
' - a copy of Rebelle

@imaginefxmagazine = ' IMAKOE | software with every

print subscription!

88 imaginefx.creativeblog.com See page 36...




Your art

Reader FXPosé
Including elven gods, warriors,
remote planets, military mech,
twisted beauties, and more.

News and events
Perfect portfolios
Pro animators tell us how to
catapult your career to the next
level by showcasing your work.

Artist in residence
Why Dutch artist Iris Compiet
is trying to cram a museum
into her bedroom studio.

Your questions
Artist Q&A

Tips from pro artists on how to

paint rusting surfaces, engaging

environments, elaborate tattoos

and much more.

Features
Interview:

Peter de Séve

The American artist tells us

why drawing well is just like

telling a good joke.

Sketchbook
Walt Disney story artist Brian

Kesinger shares his sketchbook - P

characters and creatures.

Studio profile
Germany’s Studio Soi has built
a reputation on skilled craft
across multiple disciplines.

Reviews
Hardware
Training
Books

Re%ulars

ditor’s letter
Resources
Letters
Digital subscriptions
Subscriptions
Back issues
Next month

Cfintents

Subscribe and save up to 47 per cent,and get a
free copy of Rebelle, worth $60

vere hardcore punks and

i stoned ‘hippies all over the place.

‘ It was a magical time”
Peter de Seve talks about his art college years

Studio profile

Artist in residence:

Iris Compiet Selling yourself
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Workshops
Advice and techniques
from pro artists...

60 Use a character
to tell a story
8 Kenneth Anderson creates
p afun cover illustration.

66 Core skills:
Rebelle -part 1

The main tools explained
by Martin Hanschild.

68 The art of
storyboarding

| Matt Jones on a key skill
for any animation project.

76 Concept design
techniques

With visual development
artist Armand Serrano.

82 Combining sci-fi
noir and fantasy
Alyssa Menold shares her
work on Shadowrun.

86 Sculpt your
concepts in 3D

A new series on ZBrush,
with John Mahoney.

= =
illustrator

Inspiration and advice from
the best traditional artists

FXPosé Traditional

Colourful gradients
Bao Pham uses wet-into-wet.

Get started with oils
Howard Lyon shows you how.

First Impressions
Jasmine Becket-Griffith talks eyes.

March 2017

Turn over the'page for
this issue’s art assets

- DOWNLOAD RESCURC

60}

Create art with narrative

JSINGC '“L:|I|ll'!r""‘

*3
Time to dive into ¢ oils¥

s “;.

-'(ai'min.e Becket-Griffith
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Resources

RéSources

Getting hold of all of this issue’s videos, artwork and
brushes is quick and easy. Just visit our dedicated
web page at http://ifxm.ag/story145teller

Use a character
to tell a story

Watch how Kenneth Anderson
creates a fun, character illustration
with an emphasis on narrative.

You’re three steps away from
this issue’s resource files...

Go to the website
Type this into your browser’s
address bar (not the search bar):

http://ifxm.ag/storyi45teller

Find the files you want
Search through the list of
resources to watch or download.

Download what you need
You can download all of the
files at once, or individually.
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EXCLUSIVE VIDEO TUITION!

Watch our videos to gain a unique insight into how our artists create their stunning art

- o

John Mahoney
Discover how to design an alien pilot
from a virtual ball of clay, using ZBrush.
Plus WIPs, brush and final image

-
--
-
- -
-
-

-
-
-

=

Bao Pham Belinda Leung Tony Foti

Witness how the wet-into-wet approach Why you should think of harmony versus ~ Take into account lighting, composition
can lead to a serene and colourful image. variety to design engaging environments. and perspective, to depict an aged weapon.
Plus WIPs and final image Plus WIPs and final image Plus WIPs and final image

Belinda Leung PJ Holden Fred Gago

See which factors are key to painting a Understand how you can quickly create Gain valuable insight into the first and most
shaft of light piercing through darkness. custom brushes in Clip Studio Paint. important stage of animation, in Fred's
Plus WIPs and final image Plus WIPs and final image Storyboarding Techniques training video.

AND ALL THIS! Detailed workshops packed with advice from the best professional fantasy artists from around the
world, including Martin Hanschild, Howard Lyon, Alyssa Menold and Armand Serrano.

7 CUSTOM BRUSHES, INCLUDING..

FLAT OIL GRASS A
‘_ Alyssa Menold uses this brush for ‘\. A custom brush Kenneth Anderson ™. Thisbrush was used torender areas

transparent shading and blending. uses to quickly suggest grass. smoothly by Alyssa Menhold.

March 2017 liniagmeRX *
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B ¥ Quentin-Viadimir
Castel

France
http://ifxm.ag/q-vcastel
castel.quentin@yahoo.fr
Photoshop

For freelance illustrator

- | Quentin-Vladimir, an

artistic calling wasn’t

always on his mind. Having

been a business student, he
came to the scene a little later in his life,
but he’s made up for lost time by
studying at art school and learning with
traditional mediums. However these
days he only paints digitally.

Drawing inspiration from childhood
stories and universes hidden in books,
films and video games, Quentin-
Vladimir uses art to travel to other
worlds, dreams - even nightmares.

The artist hopes to develop his own
personal style and “make people enter
worlds they don’t know yet, make them
dream and travel across both good and
evil universes,” he says. “My dream job is
to be a concept artist for a AAA video
game production. | have a sci-fi comic
book project, too.”

“" THUNDER WITCH “I’'m a big fan of

fantasy and | made this piece as a
tribute to this kind. Motion and lightning
effects helped me to convey a sense of
action and frenetic battle.”

“ LADY GALAXY “This is personal
« » work from a series of mine called
Twisted Beauties. Space and outer
worlds inspired me to come out with a
strange design.”

fiESieRX March 2017

Email your submissions to fxpose@imaginefx.com
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THE PLACE TO SHARE YOUR DIGITAL ART

Stist orit

: Illustrator Mélanie Delon loves how :
Quentin executes !ns ideas on the canvas...
\ “Quentin-Vladimir’s art is wonderful,
! especially his Lady Galaxy piece. I adore the -
concept: the way the character floats in space, o
\ and yet is connected to all the elements.”

Email your submissions to fxpose@imaginefx.com March 2017 IiiSiieRX v
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;I'HEmTO SHARE YOUR DIGITAL ART

== Dominik Mayer
Germany
dominik.t.mayer@gmail.com
http://ifxm.ag/d-mayer
Photoshop, Maya

Dominik is a concept artist
I ’ and illustrator who first

began experimenting with
A ; ‘ 3D art while studying

design at the Nuremberg
Institute of Technology. Initially, he was
interested in making movies, before
discovering the field of concept art.

“I went for a concept art internship at
Goodgame Studios in Hamburg and
learned a lot there,” he explains. “After
that | began freelancing and finished
my studies. Now I’'m working as a
freelancer for international clients.”

As well as being inspired by everyday
life, Dominik’s illustrations are heavily
inspired by history, especially the Middle
Ages. “l love to paint fantasy stuff with
dynamic action and rich colours,” he
reveals. “But | would say one of my
biggest inspirations is nature itself. It
creates so many crazy interesting
things. | always try to observe these and
mix them with fictional elements.”

“There’s a definite

look of epic cinema

about Dominik’s
paintings. His daylight

compositions are striking
in themselves, but the
Silver Seven sunset
artwork is on another
level! There’s so much
story going on in here.”

S Wil Nod R o

THE SILVER SEVEN “This one was

really fun to paint. I just had 30
minutes before | had to catch a train
and my topic was The Silver Seven.
| started with some random shapes.
Some happy accidents and warriors
with horses later, and the Seven Riders
of the Bloodmoon were born.

HONOR “At this time in my life | did
« « a lot of dark and mystical paintings,
and so with this one | wanted to do
something with peaceful colours: blue
sky, fluffy clouds and some lovely
flowers on the ground. To break up this
idyll, the charging samurai army enters
the scene. | love such contrasts.”

““7 LAZY AFTERNOON “I love to paint
“u ' knights on horseback. In this one

I wanted to create a very relaxed mood
on a peaceful day. The man enjoys the
ride and the banner is fluttering in the
warm summer sun.”

March 2017 IiiSiieRX v




STARLINER TRADING HUB

“A crashed starliner is refurbished as
a trading hub on a remote planet. | tried
to put some emphasis on its logo by
making use of very saturated colours.
I made this painting while trying out
Otoy’s OctaneRender.”

&SR March 2017
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Email your submissions to fxpose@imaginefx.com
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IMAGINEEX CRIT
“Leon’s skill here is
to use light to draw
the viewer'’s eye

across the hull of the liner,

to indicate that the wreck
is now a bustling habitat.

This is also a great

example of how 3D and

2D tools can be combined
to best effect.”

Cliff Hope,

Operations Editor

Email your submissions to fxpose@imaginefx.com — March 2017  IiviaSiieRX *
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THE PLACE TO SHARE YOUR DIGITAL ART

=== Sjlas Owen

Slovenia
www.swevenfox.artstation.com
boundtofoxes@gmail.com
Photoshop

Apart from some art
lessons at school, Silas is a
self-taught artist who
learnt everything about
= ¢ digital media through trial

and error. By trying out different options
and practising on her own, she’s able to
truly express herself and her thoughts.

“I have a huge love for symbolic art
and surrealism, often with a hint of Art
Nouveau,” she explains. “I’m also a fan
of surrealism and symbolic work such as
the Tarot Arcanas and the hidden
meanings behind these pieces. When
| draw | want to draw a story, not just
something which ‘looks cool’.”

Currently working as a freelancer for
various clients, Silas hopes one day to
realise her dream of working as a 3D
concept artist.

“Engaging character

designs combine

with unusual colour
schemes in Silas’ fantasy
art. There’s a pleasing
traditional media look
to her work that adds
another level of
appreciation for the
viewer - lovely stuff.”

" WHEEL OF FORTUNATE “This
personal piece is based on Final
Fantasy XIV. | love to experiment with
surrealism and symbolic elements in my
work, and this one got a bit of both.”

“5 ONCE IT WAS BEAUTIFUL “Here’s

« » my personal favourite. It features the
character | created in the world of
Dragon Age encountering one of the
Elven Gods from the game. As the game
itself gave no real visual on their Elven
gods and goddesses, the design for him
was based on my friend’s idea.”

“ 7 BREAK YOUR CHAINS “Dragon Age
< is my top video game, so | just had
to paint various characters from it. | was
playing with symbols and hidden
meaning in this one, imitating their
official art style mixed with my own.”

March 2017  IiviaSiieRX *
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== Darek Zabrocki
Poland
www.darekzabrocki.com
darekzabrocki@gmail.com
Photoshop, 3ds max, ZBrush

Despite his youth, 25-year-
old Darek has already

been a concept artist and
illustrator for eight years.
However he’s been working
towards this early success for most of
his life. “Art was always my biggest
passion while growing up,” he explains.

Having switched to digital art in 2007,
Darek has gone on to co-found the free
online art community for teaching and
sharing, Level Up!, in 2013. “I realised
then that concept art is what | want to
do with my life for good,” he says.

Since then everything has taken off
for Darek, and his client list has grown to
include the likes of 20th Century Fox,
Paramount Pictures, Wizards Of The
Coast and more.

-

? “Darek’s artwork is
3 rich in atmosphere.
£ h In his Assassin’s
Creed image, you can
almost smell the stink

of the Thames from 19th
century London. And just
look at the lighting on
show in Accolade! Darek’s
success is well deserved.”

ASSASSIN’S CREED: SYNDICATE
. WESTMINSTER RIVER “One of
many concepts | made for the game.
It was definitely one of the biggest
breakthrough projects in my career
so far and | learned a lot from it.”

ACCOLADE “This was a personal
« = picture | started for my 2015
presentation at the Splash graphics
conference in Prague. | had imagined
the piece in my mind for a while, but |
think | had to wait until | grew as an
artist before | could pull that idea off!”

“ " SPIDER THE NEW TOY “Here’s an

/ @xample of work that you do and no
one is expecting it from you. But it
shows you can be versatile. | wanted to
get out of my comfort zone and do
some military mech sketches. It’s an old
one but still remember how much | owe
to this painting.”

ESieRX March 2017

Email your submissions to fxpose@imaginefx.com
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Send up to five pieces of your
work, along with their titles, an
explanation of your techniques, a
photo of yourself and contact
details. Images should be sent as
300DPI JPEG files.

Email: fxpose@imaginefx.com
(maximum TMB per image)

Post: (CD or DVD):
FXPosé
ImagineFX

Quay House

The Ambury

Bath, BA12BW, UK

All artwork is submitted on the
basis of a non-exclusive worldwide
licence to publish, both in print
and electronically.

Email your submissions to fxpose@imaginefx.com March 2017 IiiSiieRX v
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AT THE CORE OF THE DIGITAL ART COMMUNITY

Perfect portfolios

Killer tips Leading animators tell Julia Sagar how
to catapult your career to the next level with a
carefully crafted showcase of your artwork

It doesn’t matter how talented an animator
you are. If you don’t have a killer portfolio
to showcase your skills, that job you’ve
dreamed of is unlikely to materialise. But
crafting the perfect portfolio or reel is an
art itself. So what’s the secret to success?
And with thousands of other passionate
animators out there, how can you ensure
you stand out for the right reasons?

We asked leading animators to share their
pro tips on portfolio strategy. Whether you
want your digital portfolio to work harder
or to make your showreel sing, there are
some best-practice tips that can be applied,
whatever field you're targeting.

W ESeRX March 2017

Golden rule one: know your audience.
Who is your portfolio or showreel aimed at,
and what do prospective employers, viewers
or visitors want to see?

“Whether you're applying to a games
studio, effects studio or a character
animation studio, you have to tailor your
portfolio to the studio you're applying to
and the type of work you aspire to do,” says
Andrew Gordon, a directing animator at
Pixar, who's worked on
everything from A Bug'’s Life,
Monsters, Inc. and Toy Story 3
to Pixar’s Academy Award-
nominated short film Presto.

“For a character design position, | look at their
drawing, painting, and design skills, and for a
variety of styles,” says Aaron.

Animage from

2 Aaron Blaise’s

N | o new 2D animated
| & short film, Snow
U\\:* Bear, which is due

—_— in the autumn.




WIZARDRY
AT WORK

We talk to the
Framestore creature
artists behind Fantastic

Beasts and Where to
Find Them, and hear

about an unusual

development process.

Page 22

Oscar-nominated animator Aaron Blaise
agrees: “Know who you're interviewing
with,” he advises. “If

&~ | hiredat Disney, | wouldn't
show them a reel of Simpsons
animation, and vice versa.
And if you don’'t have the
type of work you think a
studio is looking for, then it would be in
your best interest to do a shot or two in
that studio’s particular style.”

HOOK YOUR VIEWER

“Keep in mind that we have seconds

to evaluate your work,” explains Disney

in its exceptionally helpful portfolio

and showreel application guidelines
(www.disneyanimation.com/faqs). That
means putting your best work first and
closing strong, as Pixar's Andrew explains:
“Realise that people will fast-forward
through your work. If they don’t see
something really quickly, they’ll turn off.”

It also means being original. How? By
injecting personality into your portfolio.
“Good character animation is the art of
bringing characters to life - not moving
them around,” points out Aaron.

He’s currently working on an original 2D
animated short film, Snow Bear, with
business partner Nick Burch, and urges
animators not to sacrifice personality by
focusing solely on movement and

were looking to get

CLOGGED UP
WITH ART

Find out why Dutch
artist Iris Compiet

is trying to cram a
museum’s worth of
exhibits into her studio,
where she creates her
fantastical pieces.
Page 24

Park City (Wasatch) is one
of a number of images in
Ty Carter’s portfolio that
shows his understanding

of design and colour.

66 People will fast-forward
through your work. If they
don't see something really
quickly, they'll turn off 9

“Game animation is
competitive,” says
Jonathan Cooper,

who worked on
Uncharted 4. “Even
veterans need to keep
pushing the quality

bar to get that ideal job.”

mechanics. “Often a shot requires little to
no movement to get an emotion across,”
he says. “It can be just a look, an eye
movement, a blink. | also advise animators
to include performances where there’s a
change of emotion or idea: angry to happy
or fearful to brave. That’s when it becomes
real and the viewer is pulled in.” 2

6oq AubneN @

MORE THAN
SKIN DEEP

Ever struggle to depict
believable tattoos?
Check out Tan Hui
Tian’s tips, among
other indispensable
advice from pro artists,
in our Q&A section.
Page 28

ANDREW
GORDON

The Pixar directing animator
talks tips, tricks and techniques

What skills do you want to see
in an animation portfolio?

I want to see that someone
understands the principles of
animation: weight, physicality,
overlap, squash and stretch. There
also needs to be good acting
sensibilities — an understanding of
how to gesture or when not to.

Anything you don’t want to see?
I don't care about rendering

or lighting. I just care about
storytelling, entertainment value,
great posing character and great
acting - the elements that make
quality feature animation. If you're
applying to be a technical director
or a lighter, they want to see great
staging and lighting. Modellers
want to see details of models.
Animators look for that spark.

What exactly is that spark?
When I see an original character
that’s well posed and has a funny
little story, I know this person is
thinking about entertainment.
That's what grabs my attention.
That's the spark.

Which portfolio traps do people
most often fall into?

When you're tailoring a demo reel
towards what you think a studio
wants to see, don't copy old tests.
Make it original. Add personality. If
you'Te going to use a stock rig from
a school, come up with an original
design and test. Don't leave the
default shading and geometry of
stock in place. It lacks imagination.

What are your showreel tips?
Show storytelling. I really love the
idea of seeing a lot of shots, and
continuity. And keep your titles
simple and classy. You don't need
a beautiful logo that’s been done
in After Effects with exploding
phone numbers!

Andrew teaches animation and
storytelling masterclasses. Get
more tricks, tips and info via
@splinedoctor and his website.

/4 www.splinedoctors.com

March 2017 IiiSieRX #
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Grandpa’s Farm.
“Keep your showreel
short and sweet,”
advises Ty.

Thumbnails from Snow
Bear. “Only include the
best, most impressive
work in your portfolio,”
recommends Aaron.

Night Hunt. “Lay out
your portfolio to
look as professional
as an ‘art of’ book,”
advises Ty.

WESHEEX March 2017

When it comes to specific skill sets,
different disciplines require different
portfolios. For Andrew, who specialises
in character animation, this means showing
an understanding of the principles of
animation - squash, stretch and so on (see his
advice on the previous page).

JUMPING IN

For Naughty Dog video games animator
Jonathan Cooper, however, this means
showing actions and a
relevant style. Jonathan is the
brains behind video animation
website www.gameanim.com.
He’s currently working on
Uncharted: The Lost Legacy, and says that
for the games he makes, he wants

to see navigation around a complex
environment, including jumping, climbing
and vaulting, one-on-one-combat, walk
and run cycles, and so on. “Dialogue and
acting scenes are a huge bonus as we're
always blurring the lines between gameplay
and cinematic storytelling, and game
animators are typically expected to at

least have a hand in both aspects on the

Ty'’s best tip for
standing out is
to be yourself.
“Find a way to
reflect yourself
in your work.”

job,” he says, adding that camera work
also helps you stand out.

As Jonathan explains, it’s essential to have
an up-to-date demo reel to keep up with the
fast-paced games industry. “A personal
website is the easiest to share with the
studio involved in hiring, but a link to your
latest reel in your resume is enough,” he
says. “I prefer Vimeo to YouTube, because
of the final render quality and overall
cleanliness of the site,” he continues. “And
ArtStation is fast becoming the standard
for pre-made portfolios. But | recommend
adding your reel everywhere - even
LinkedIn. As for a physical portfolio, | don’t
think I've seen one in years.”

Lisa Allen, an animator at Blue Sky
Studios and recent portfolio reviewer at
November’s CTN animation
expo, echoes the sentiment:
“Your showreel is really the
only part of your portfolio that
matters for getting a job as an
animator. Ideally, the pieces in your showreel
demonstrate your eye for acting, posing,
design and composition. If you've done work
in any other categories like life drawing, or
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Mission Selva is a personal
piece by Ty Carter. He breaks
down the process in a tutorial

on his Patreon page.

illustration, that’ t - but keep th | 1 b 3 Ty's image C Meet |
lustration thats great -butecothen | @l We are in the business of chot o s i,

in a separate part of your portfolio website ThesieEpecifictone

instead. Also, less is more. For me, the : entertainment. I Want your discipline,” he says.

perfect reel is between three and five clips

and arotind a minute long” - portfolio to entertain me 99
GOI.DEN RUI.ES E i Drift, Epic, and The Peanuts Movie, and

Another golden rule for a successful | he shares all kinds of useful tutorials
portfolio is to create a clear focus. If you're { and teachings on his Patreon page

showcasing a number of core abilities, make (www.patreon.com/tycarter).

sure the direction in which you want to take i “It's good to see one major focus like

your career is clearly presented. “Successful | character design, set design or colour. If you

portfolios are specific, organised and | do each of these at a high level it doesn’t
contain original ideas,” i | hurt to show them all, but be careful not to
says Blue Sky Studios visual i | include too much. What’s most important

is showing you're a creative problem solver.
Ask yourself, what do you bring to the table
that no one else can do? Is your own life
experience reflected in your art? If not, how
can you do that?”

Most importantly, it's about storytelling.

Don't fall into the trap of being a shot
> animator,” warns Andrew. “People don't just
| want to see great animation: they want to
see if you can tell a story. You have to put
i together the pieces so that you're showing
| you understand cutting, continuity and
| staging. You don’t need complex rigs to get
i noticed. Just great ideas.”
“At Disney we would talk about portfolios

I that stuck out,” agrees Aaron, “and they
: stuck out because the work was consistently

development artist
Ty Carter, His film credits
include Ice Age 4: Continental

B ——

“At Blue Sky we look for animation with i o )
e e el | entertaining throughout. We are in the

SEESIE TR I LM | business of entertainment,” he smiles.
worked on The Peanuts Movie. I ) . P ‘
i “I'want your portfolio to entertain me.” {i§ I/
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The Diricawl is a flightless
bird that can appear
and disappear at will.

A concept created to show
the full effect of the
Thunderbird in flight.

How to create Fantastic Beasts

Creature feature The process of designing creatures for JK Rowling’s latest
blockbuster was a little unusual, as Framestore's concept artists explain. ..

London studio Framestore is best known
for its visual effects work on films such

as Gravity. But it also has a top-notch art
department, which was recently tasked
with creating creature concepts for

JK Rowling’s latest blockbuster Fantastic
Beasts and Where to Find Them.

The way these designs were to be
developed, though, was a little unusual,
explains animation supervisor Pablo Grillo.

“The conventional method is that art
departments start with illustrations,
sketches, 2D images,” he says. “These then
get turned into 3D sculpts,
which are handed over after
shooting to a post-production
facility, who then animate
them,” he says. “It’s a very

linear, baton-passing process.” But here
producer David Heyman wanted the artists
think about animation right at the start
of the process, as an integral part of
developing the concept designs. “There'’s
a lot you can develop through movement
and also narrative ideas,” says Pablo. “The
idea being that the design of the drama
informs the concept.”

In practice, that meant the art
department found itself in a continual loop
with the animators, as the creature designs

66 It meant knocking most
niggles out of the creature
design at the beginning 99

An exploration of the
Niffler’s coat, trying
out downy hair rather
than feathers.

were passed back and forth to finesse
things as much as possible.

As a case in point, concept artist

1 Sam Rowan’s design for the
Niffler, a rodent-like creature
with a long snout, was taken
into pre-viz (an early, basic
| level of animation testing) and
then sent back by the animators with
feedback and requests for changes.

“l was told, for instance, that he needed
to pick up coins, but the massive paws I'd
given him made it difficult to do so,” says
Sam. “They said I'd made him too fat to
move properly as well. There was a lot of
back and forth like that.”

For concept work on characters such the
Erumpent (a huge African magical beast

A young Marmite - a
tentacled cross between
a dust mite and a squid.




Artist news, software & events

3 The Occamy had to
resembling a rhino), the s S look elegant and
“ \ | svongeviaiaoe , 1 ' o b s
- butterfly-like creature), and . p E % side when threatened.
the Obscurist (a barely visible, e : :
malevolent force), fellow artist
Dan Baker had a similar experience.
“There was a lot of discussion with
Pablo and the pre-viz guys very early on,” he
says. “We'd have a look at Pablo’s sketches,
I'd come up with some stuff, and it was all
really a group task.
“The Obscurist was particularly
challenging, as you had to show a force
of terrifying dark energy without actually
seeing it. We solved that by creating a lot of
swirling debris around the actual creature.” . y The Swooping Evil
But rather than finding this non-linear way juxtaposes the wings
of working onerous, the artists all responded i g::ai’ﬁgwmgke
positively to it. “It seemed like a healthy, terrifying animal skull.
breath of fresh air way of working rather
than being stuck in a room by yourself,” Sam
says. “And by keeping all these changes up
at the front of production, it meant you
could knock most of the niggles out of the
creature design right at the beginning.”
To learn more about Framestore’s
art work on Fantastic Beasts, visit
www.framestore.com/fantasticbeasts.
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Here’s my fully functional architect’s drafting table.
lusually keep it flat: the large working area leaves
room for my art and my cats.

The space between my digital and traditional setups
isn’t big, so | can easily switch between them. If you have
a small studio like this then you have to be creative.

.
" Lenastesasl 1 A ]
PP 11" 1112 2 (e e e—

© Jelle Mollema

e

| do have a bit of a sketchbook
addiction - | buy them in bulk.
And there are stashes of new
books everywhere!

—EDENCE

| bought a Yiynova tablet rather than an
Cintig. It’s the ideal alternative to Wacom’s
device if you need to paint digitally, but
don’t want to spend lots of money.

Iris Compiet

Cabinet of curiosities This Dutch artist is trying to cram a
museum into a converted bedroom studio. Find out why...

One of the best things
about my studio is that it’s
got adoor! | can step into it
in the morning... and close
the door behind me when
I’m done in the evening. It’s my sanctuary.
But it’s small and getting too small, so I'm
invading every other room in the house. My
stash of shipping supplies, frames, boxes of
sketches and photo studio setup has taken
over the attic, while my silk-screen area has
moved into the smallest bedroom in the
house, and the bathroom is where | mount

ESeRX March 2017

| collect items to use as
props in paintings or to
turn into works of art.
This old porcelain doll is
set to become a weird
business card holder.

watercolour paper to board, wash my silk-
screens and generally use as my room for
nasty experiments.

My digital setup is on one side of the
room, and opposite this is my pride and joy:
an antique architect’s drafting table, which
is over 100 years old. | can put it in an angle,
but | prefer it flat because | love to spread
out my sketches, materials and books when
I'm working. Furthermore, | tend to work on
different tasks each day, so I like things to
be close at hand, switching between
projects as the day progresses.

I love this chest of drawers, which my mother
salvaged from an old school. | put wheels on it and
use it to store my smaller supplies. | place my paints
on when I'm using oils, and my easel will be next to it.

Sometimes my easel is set up in the room
as well and I'll work on oil paintings between
client work. | like to work on different things
at once; | find it keeps my mind fresh. When
| hit a roadblock with one project I'll put it to
one side and work on the next one, while my
subconscious comes up with ideas to solve
the problems I'm facing with the first task.

| usually get up at around 6am and start
work at around 7.30am. I'll put on an
audiobook, check up on some emails and
then do some warm-up sketches. | try to do
all the boring, business stuff before 10am,



Artist news, software & events

| like to take old porcelain dolls and turn them into something else. I try to find elaborate frames everywhere | go. | always intend to use
This is my octobaby and it’s a work in progress, but for now it keeps them for a piece of art, but end up keeping them myself because | love
a watchful eye on me... and freaks out anyone who visit my studio! the tacky gold frames. Oh, and that’s Edgar - he’s my studio crow.

This is my cat Hyde. He
and his brother Jekyll
will always stay by my
side when I'm working
in the studio. They like
nothing better than to
be right in the midst of
the action... preferably
right on top of a freshly
painted image!

These mugs were
bought at an antiques
market in Bruges. The
skull-shaped mug is
used for cleaning my
brushes (when I’'m not
using my tea mug) and
the doll head is actually
a flower pot.

and then it’s full-on art! | have a little digital
clock that goes off every hour, which lets
me know that it’s time to take a break and
make a cup of tea.

I've got loads of books in my studio as
well as art that I've collected over the years.
It’s nice to have all of this close at hand - it's
my emergency inspiration boost!

Iris enjoys working on projects ranging from
picture books to gallery art and even sculpts her
own frames. Creating a “sense of wonder” is at
the core of her work, which you can see by
visiting www.eyeris.eu.

I have art by artists | admire in my
studio, bought or gifted to me.
They are my treasures.

The all-important
kettle. | can’t live
without it. | need my
tea next to me...

Just a small part of my
collection of oddities.
Since my studio is small,
alot of it is in the living
roomand | tend to
bring stuff up to my
work space to use in my
paintings. | love looking
at things like this to fire
up the imagination. The
little ray is the newest
addition to the freak
show and it’s perfect
for when I’'m working
on mermaids.
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Letters

YOUR FEEDBACK & OPINIONS

Contact the editor, Claire Howlett,
on claire@imaginefx.com or write
to ImagineFX, Future Publishing, -

Tom'’s experiencing trouble getting our artists’ custom
Quay House’ The Ambul‘y, brushes to runlproperly on his home co;nputer.l
Bath, BA1 1UA, UK

. this, I did download one viewer at
u Follow us on Twitter: S F M or almost
www.twitter.com/imaginefx ource Yorge, ahd my computer aimos

immediately crashed.
Tell us your thoughts on Facebook: Y

facebook - inef I'm sure a lot of your community would
www.laceboo 'Com/ Imagrnetx appreciate it as much as [ would if

r@] Post your art or photos on Instagram: ImagineFX could provide in upcoming
www.instagram.com/imaginefxmagazine issues, as part of its resources, a safe, proven

.Abr viewer so we too could share and try

out the brushes that you regularly supply. r@] “Gear up I Titanfall 2
Tom, via email 7
concept art.

A

Your art news that's
grabbed our attention

Digital manga?

Just enquiring about manga
magazines. I was wondering if
you do any issues that contain
computer-generated manga?
Alton, via email

Claire replies Great idea, but it's the ‘safe,
proven..." bit of your letter that we're unable
to help with. We cannot supply third-party
software in case something goes wrong with
it, or it isn't compatible with certain
operating systems, and so on. It’'s a tough
one! Perhaps other readers who do a similar
thing to you can share how they do this?

Claire replies All of our manga
editions have imagery that's
created using computers and
software such as Photoshop.
They also feature traditional art

advice. Our most recent special Index please!
manga edition is available here: , I've been buying your wonderful magazine
Learn how to paint all . .

http://ifxm.ag/manga-artist3. things manga, in our for years, but wouldn't it be great if they

, , recent special issite! could be used as a live resource rather than
Can't read the magf an impressive p%le of magazines stuc‘k on my Lois van Baarle
I love your magazine, but why is the text so shelves to be enjoyed randomly, which is @ loisvh
small? Sometimes I find it really hard to pretty much what happens in my case. @ o1
read - especially the hand-written stuff - Imagine a scenario where it’s possible o 5
and I have to squint to be able to read it. to access the Contents pages of every @] Coloured in my
I know this makes me sound like a right old ImagineFX available digitally, and search Wo_nder Woman sketch.
fart, but it has to be said! them by keyword? Then people like me, I tried to use a more
Darren, via email who still favour the print version, could look traditional comic style

for topics of interest in the Database of of COlOUIiIlg! Was fun

Claire replies Darren, ['m so sorry that Contents and go directly to their print to try out.”
your eyes have been hurting while reading edition(s), or buy missing issues that feature
our magazine! We're always thinking of the content that they're interested in. For
ways to improve the magazine, so we'll take digital versions, perhaps the search would
alook at how and where we could make create Bookmarks automatically.

things more readable, if necessary. Do other
readers agree? Or do you have any other
niggles to tell us about? Drop me a line!

Of course, your readers may already have
this kind of feature, which makes me look a
bit daft, but I can live with that!

Max, via email

Can’t open brushes

Most every month your magazine shares
some utterly wonderful brushes, but I can
almost never use them.

Like I expect many of your readers,

Claire replies Hello Max, this is another
great idea. We would dearly love to create a
searchable index for our editions - it would
help us here in the office as well! Alas, we

I mostly use Manga Studio (or Clip Studio ) just don't have the resources to get this Shann(.)n R?SQ

Paint as it's now known) for my own digital sorted. I even asked our apps team if they @SacrmoxmArt
work, which doesn't natively handle could create something within our - ”
Photoshop brushes. So I have to load the Turn to page 46 magazine container app for our digital 1 “Corvo Attano fan art.
brushes individually into Sketchbook (the to see how you editions. Again, it’s just not something that - .

only reason I still own it) and createastamp | c3n get hold of we can supply at present. {1 ';]5; JZ:’?Z‘ZZ ;g:)'f:ﬁ;lg L’ZHT';’]?;;“ to shout
to then make my own brush. Alternatively, this ;.1nd other I'll add it to the big list of things I'd like to (@i dl inef), or finc}l’ us on Facebook!

I'll try and use an .Abr viewer. Having said past 1ssues. get done in 2017. Thanks for writing in.

* ESHERX March 2017
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ImagineNation Artist Q&A

Artist

STRUGGLING WITH A PAINTING TECHNIQUE OR
TOPIC? EMAIL HELP@IMAGINEFX.COM TODAY!

The

lmagln%!%gl

Tan Hui Tian
After some time as a game
artist, Tan is a senior illustrator
at Collateral Damage Studios.
Her academic background in
graphic design can be clearly
seenin her illustrations.

http://ifxm.ag/th-tian

PJ Holden
»= = A Belfast-based comic artist
} known for drawing Judge
Dredd in 2000 AD and the
Nu-Earth series Hunted, PJ’s
recently drawn tanks for Garth
' Ennis and World of Tanks.
www.pauljholden.com

Belinda Leung
r Previously a lead artist in
‘ the games industry, Belinda
is now a freelance illustrator
\ and concept artist who
' specialises in designing
& . for films and games.
www.belindaleung.com

Tony Foti
Tony is an artist at Konami,
who also contributes
freelance work to numerous
books, trading cards, games
(board, tabletop and video),
. magazines and adverts.
www.tonyfotiart.com

Artist QfA
Need our advice?

Email help @imaginefx.com
with your art questions and
we'll provide all the answers!

v ESeRX March 2017

I've chosen a clean
aesthetic for the
character with a white
colour scheme, to
create a contrast

with the tattoo.

Question

Can you help me paint an elaborate tattoo?
Yolanda Conley, US

Answer
Tan replies
Tattoos can certainly add
ﬂ visual interest to a character
N ' ) and are straightforward to
4 paint. There are many tattoo
styles to choose from and I've picked one
that’s a mix of geometric and tribal.
Apart from the tattoo style, there’s
also the age of the tattoo to think about.
Fresher tattoos are more opaque, and the
pattern on the skin may be raised, with
reddish irritated skin around it. Older
tattoos are faded and tend towards a
greenish-blue tint if a conventional black

ink was used. They may also be distorted
according to the topographical changes of
the skin they're on.

A temporary fake tattoo and a real one
will both fade, but in different ways. In
the former, the pigment flakes off and
may crack according to points of stress
and the epidermal structure of the skin.

A real tattoo becomes faded because of
sun exposure, and suntanning also creates
a layer of brown tint on top of the tattoo.
Over time, the lines of a tattoo will
become less crisp as well.

To make the tattoo look
less digital, | go over
some layers with a
grunge brush with the
Transparency locked. To
fit facial contours liquify
the tattoo in broad
strokes before refining.




Your questions answered...

Step-by-step: ® | Question e
* _ Create a realistic, How can I quickly create custom | WORK<HOD b

complex tattoo brushes in Clip Studio Paint?
hd Barry Simons, England

NECK

L3
. Break elaborate designs down into
parts, and use repeating elements
-('Iil_<‘__@ the geometric shapes here) to make
it look cohesive. Get an idea of where each

part goes beforehand by sketching out
the tattoo on the portrait first. The tattoo
doesn’t have to be perfectly clean, since
real tattoos are done by hand.

You can produce a complex silhouette by waving the brush around
and applying pressure to help generate random patterns.

PJ replies
Every first-time installation of Clip It's always easier to start from an existing
Studio Paint involves an excited brush and build up. So find a Decoration
exploration of the Decoration subtool you think might do the job — most
subtool. It’s a veritable smorgasbord of my more successful silhouette brushes are
of natural, unnatural and downright goofy derived from the Foliage brush - and use the
brushes that can quickly generate rock- Create Copy of Currently Selected Sub Tool
encrusted wastelands, dense forests or, more icon to duplicate it and then edit it.
likely, just a random smear of black and white. Once you've designed a few of your own more
In my experience, this toolset quickly gets useful decorative brushes, you can drag them
relegated to the digital equivalent of the bottom | out of their subtool and on to the toolbar on
~ drawer. There is, however, a way to fix this, their own, grouping them together to save time
. Place your flat design where you want, turning it from a little-loved tool into an hunting for them when you need them.
then Transform>Distort its layers to absolutely essential time saver.
-mggch the perspective. For simpler curved Think about creating silhouettes: using . =
surfaces (say, across a calf), Transform> your own custom-made brush tips is key here. 1 4 = 4 f i {
Warp might do. For greater control, | use A variety of leaves (hand-drawn or scanned and "R & 2 R R R A R o A A g
Liquify. Click Advanced Mode and Show traced) combined can look like a dense bocage,
Backdrop with the settings shown, so you a set of random blobs add up to the intergalactic
can see the background while liquifying. power of comics legend Jack Kirby’s “Kirby

Krackle” effect and a crowd is really just a mass
shape composed of numerous individuals. Each
brush tip should be made of a simple silhouette.

L
. For this subtler, aged tattoo look,
w¥” |'have a layer in Overlay mode and
'ot._FLers in Soft Light and Multiply. | alter the
Opacity to blend with the skin and use
Gaussian Blur, because an old tattoo will

‘ Artist’s secret
GXPERJMENT WITH SETTINGS
if yrm want tv yer the raynr bind of umpact;
£ esseneral to learn how ¢ach of the sectings
Fluence how e
the Spray effeet will onf
| p ro A rﬂMWV\ fmqf of each

lose its crispness. For a new tattoo, select ‘ hanette u creatd. Hlinse, bt vl
. . i i i with
Blendmg OptIOﬂS and add Soft Glow set to quwavanety ofshapegoqc—}smgle layer in black and jmm “’f may Mrrk MH’ A9¢: o
. . T X white, then select them individually and add to the brush 2 Crowds W WW ¢. ST a(f/rm'\z%
Multiply for a red outline of irritated skin. list using Edit>Register Image as Material. work PWV with 2 &
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Question
What tips can you share for painting a rusting surface?
Rhonda Hambly, US

Answer
Tan replies

P | Adding a way to depict rusty

H surfaces to your repertoire
=~ \ | can be helpful, especially for

y )1 painting backgrounds. Rust or
iron oxide occurs when unprotected iron
comes into contact with water. This means
it usually indicates old, weathered metal
objects, and can add realism to any scenes
where wear and tear is expected. Iron is
usually protected with a layer of paint, and
it can add interest to depict rust interacting
with flaking or welted paint.

When painting rust you should take
note of the physics, such as where water
would come into contact with iron and
where the iron object would experience
stress. For instance, in the example I'm
painting of an abandoned car in a forest,
the metal grilles in front might rustin a
different way to the car body. Rust forms
in streaks (for example, on the car door)
where water has presumably flowed down.
But because the main car body has been
protected by paint, the rust is milder on it.

Other weathering effects occur as well. Weathering can make an artwork more

evocative because it implies a narrative.
Moss forms on top of the car, as the spores Each scratch and dent on a vehicle tells way v Wﬂ
would land and stay on top of it rather of iFs history, a_nd can make the viewer m,ﬂga I V/ ‘VLFL‘W
. curious about its story. m (Wif o tu

than collect on the sides. 0 mWM Flendi g

Adding headlights and tweaking the lighting
creates a different, slightly eerie atmosphere.
It’s no longer just an old, abandoned car...

o g—

e | -

[ . § . B B K _EN
. 4 R OR B A

‘ Artist’s secret

ADD VARJETY o
Rust er )LVV\PM a sy @‘6 moncf'mfm ﬁr"rrwt/b.
it can e 2 ﬁmo}mmw of colovurs. The easest
)ym o7 “ colowr vananet rv your

g a re/rwe Lftv/er set v
p of  the unage

Step-by-step: Applying rust to a surface

[ . [
Before you add rust to Istart off by layering the
any surface, you'll need textures as appropriate. |

-objects that are made of iron. -usg-the Liquify filter to warp

Réther than painting an object
shiny and new, it will be easier
if the surface is already dull or
matte with dust and dirt onit.
That means there’s no need to
spend time painting in specular
highlights. I'm using textures
from www.textures.com,
which are free to download
(with a premium option).
[

Continue to layer textures

on the car, while keeping
in-mind how real-life physics
would affect the weathering.
For instance, the constant day-
night cycle would make the
metals expand and contract at
different rates, and therefore
bend the radiator grille and
even the body panels out of
shape. Rust will be worse
wherever the metal has been
scratched or damaged.

thee rust textures so they fit the
contours of the car. To show the
background, click Advanced
Mode and Show Backdrop. You
can also use Puppet Warp or
Warp for simpler contours.
Erase the edges of the texture
so that it blends with the
surface of the car, and set the
layer to Overlay or Multiply.
[ P
- .The image is beginning to
look a little flat, so | go

‘over it with a simple grunge
brush so that it doesn’t seem
too clean. | add other details
such as a layer of moss, broken
glass and reflections from the
environment as needed.
Because any glass would have
become grimy and dusty over
time, | apply a blur to the
reflections and give them a
more matte appearance.




Question

How do I add an aged look to an axe or similar weapon?

Barbara Konig, Germany

Your questions answered...

You can also use the background to
explain more about why the weapon is
in such a state of disrepair.

Answer
Tony replies
Before you can paint an old, worn
battleaxe, you're going to have to
design a new one. As always, spend
BLSER.  some time looking at designs from
the time period you're working from - unless
it's fantasy, of course, in which case just look at
everything. Your workflow should start with
the axe design, then figuring out a composition.
Once you've got the composition, decide on your
lighting and then finally paint and wear down

the weapon. Use a perspective grid to make sure
every part of the axe that should be symmetrical
is actually symmetrical.

When you do start sketching the blade and
embellishments, just focus on one half and copy
it over. This is especially useful with little design
motifs on the blade, which can be hard to match
up. You can then copy this layer and drag it down
a few pixels to create the bottom plane of the axe,
controlling thickness with distance.

Once your sketch is done, you can get down to
painting. Silver metal (and any colour that’s close
to neutral) will tend to take on the hue of the
surroundings. Ensure whatever colours dominate
the background are also in the axe. Chips in the
blade and scratches along the surface imply
previous battles. Spots of rust can show age and
give you places to change up the textures a bit.
Keep adding on the wear and tear until you feel
there’s too much, then start trimming it back.

Step-by-step: Painting a battleaxe that’s seen action

.
Start by loosely sketching out the
@ image as you imagine it, without

-getting too caught up in any detail or

pérspective nuance. Then, using that
rough sketch as a guide, draw out the
shape of the
axe and any
decorations in

a flat, top-down
planar view. Use
the Pen tool for
smooth, precise
curved lines.

..
Focus on drawing just the left half,

» then when it’s finished simply copy
the layer, flip it horizontally and line it up.
This way you know the two sides match.
Now figure out what the sight lines and
vanishing points
are doing in your
rough, then use
Free Transform
and Skew to lay
the flat design
down in the right
perspective.

(‘&”’ a(\p\__: .\‘l\\

5 LIS S 4 »
A 4 \(. \
4 '

F ﬂ\
N\

LT
Paint the axe using the sketch as your
w guide, and always take into account

‘hoy_v' the light will be reflecting from the

mietal. You can use the eraser or the
colour of the background to paint some
chips into the
blade. Show the
stains of war and
the dirt, along
with scratches
that catch the
light with dark
reds and browns
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Question

I want to design an engaging environment — any tips?

Tom Blau, Germany

ImagineNation Artist Q&A

Answer
Belinda replies
e My first approach to making
- a potentially mundane scene
| look interesting is generally to
use the principle of harmony
versus variety, to spark interest in an image
and create a focal point.

People have a natural tendency to look
for patterns, so providing repeated shapes
throughout the image but in a variety of
sizes will encourage the viewer to scan the
image. Counterpointing these repetitive
shapes with something different will cause
the eye to settle, and these contrasting
areas are perfect for the focal point for
your image. This is where you can perhaps

A

gt
In this scene | use the repetitive curves 1 529
of the rocks and path to create a sense &,
of harmony in the shapes, which |
contrast with shafpsangular buildings.

add a story element or character interaction
to really draw the viewer in and keep them
looking around.

This principle of harmony versus variety
doesn't just apply to shapes, but also works
with contrasts in colour, value, line and
other art fundamentals. The idea is to create
a sense of overall unity within your image
using any of these aspects or combinations
of them, then interrupting it with a
contrasting element where you want the
viewer’s eyes to settle. An image that has no
harmony in it at all will give the viewer a
hard time scanning the picture, yet on the
other hand a scene that’s too harmonious

| create a silhouette to
establish the overall
contrast of round and
angular shapes. The
silhouette in the final
image is pretty much
the same.

will become bland and have difficulty
grabbing the viewer’s attention for long.
I like to maintain a ratio of about 80:20,
in which 80 per cent of the image is
harmonious, with 20 per cent featuring
contrasting elements.

For your focal point, try using either
colour accents or areas of dramatic value
contrast. Also consider depicting an area
of quiet in a chaotic scene.

-

-t -
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‘ Artist's secret
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Adjustment layers can give you
great control over the lighting in
your image, from ambient lighting
to directional shafts of light.
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Question

Help me paint a shaft of light

Qi Meng, Australia

Answer

Belinda replies
g W | Thereare few things that can
evoke a sense of magic and
wonder more simply than a
| glimmering stream of light
piercing through darkness.

To make the lighting believable and

effective, you'll need to take account of a
few factors, such as the mood you want

to convey and the kind of atmosphere the
light is shining through. For example, is it
a dusty room or a crystalline cavern? The
effect of the light can also create a range of
feelings such as mystery, hope, sadness and
nostalgia, depending on the effect of the
light on its surroundings. If a character is

%

side-lit by a sliver of light with their face
remaining in shadow, they might look
threatening or mysterious, whereas if
their face is lit by the light, they could
look hopeful and thoughtful.

Here I've painted a simple scene of
a dusty old room to demonstrate some
straightforward Photoshop techniques for
how to approach painting a shaft of light.
The technique uses layer blending modes
and adjustment layers for maximum
flexibility, and it can be used for other
forms of lighting situations, too. Have a
play around with this technique to create
different lighting effects.



Question

How can I make an object look like it’s moving fast?
Leon Thornton, England

Answer

Tony replies
There are all kinds of ways to
make something look fast-
moving. I'll go over a couple
of different approaches, with

the help of a time-travelling pilot.

The first thing to consider is whether
the ‘camera’ is tracking the object. If so,
the focus will have sharper edges and
the background will be almost all soft
edges. If the camera is stationary, the
background will be clear and anything
fast is going to be a blur. I've done
something in between the two, so you
can see how both approaches work.

For a background in motion, try
using Filter>Blur>Radial Blur, ensuring
it's set to Zoom. Use the little grid to
move the focal point over your desired
vanishing point (remember to keep all
motion visuals in perspective), and
you'll get a kind of tunnel blur effect.

Your questions answered...

Motion blur is a great start for implying ,‘ 3 ‘
A 4 " Vi

movement in an illustration. Make sure to keep
things in perspective, though, and don’t soften
everything so much it becomes uninteresting.

@ Artist's secret

For a fast-moving focal point, [
suggest painting the subject on its own
layer. Then you can duplicate it and use
Filter>Blur>Motion Blur. You'll end up
with a ghostly streak effect that suggests
an object moving a large distance fast.

Another way is to have the colours
and values from an object bleeding back
in perspective, like comic-book speed
lines. The red bombs bouncing around
are examples of this effect. For every
layer you want to treat this way, I suggest

DIRECT THE EYE

Use the mi UW/NM . mtr
Lener's %

unage 7 dureet fW’

2. ot y(ﬂ*(w //M(rt

mavement 07 (’M/’ Vi
want em/muﬂ U the puect
flur s 2 pmgr il

tv lead v
ﬂuvﬂm
w{ focal pount; and et

way v Fluence what pec}w pay attentuon

making a blurred and non-blurred

Composition is another big component in expressing movement. Have figures
version. Adjust Opacity to refine later. leaning into their step to give the impression that they’re hurtling forward.

Step-by-step: Bring in directional lighting

P .

!u@

T ~ay

[T

l*start by painting the environment . I*start with a Levels adjustment layer = Fhis strengthens the direction of the

using local colours only, without the to brighten everything up, then invert w# light. To add atmosphere to the light,
effect of directional lighting. | sometimes the layer mask and paint into it to create Tuse a Color Dodge layer to paint in some
start with darker or lighter local colours to the light source and areas of bounce light. specks of dust lit by the stream of light. |
set the initial tone of the image, such as a | then use an Overlay layer to paint the also use this layer to add hot spots of
dark, mysterious scene or a light, hopeful triangular beam of light and add some lighting to other areas of the room that
one. Only then do | add the light source... soft cast shadows around the room. are being directly hit by the light.
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Need our help?

If you have a question for
our experts, email us at
help @imaginefx.com

Question

How do I set up my comic panels?

James Barnstaple, England

Answer
PJ replies
¥ At its simplest, a comic page is
. made up of a number of images
called panels or frames. (In the
US you're more likely to hear
the word panel than frame - they mean the
same thing, but frame is Clip Studio Paint’s
preferred term.) Frames are separated by a
gutter, and it’s the gutter that performs the
magic in the reader’s eye of coalescing
those frames into a single coherent story.
Clip Studio Paint has tools for everything,
including creating frames and their borders,
and here I'll discuss ways to simplify the
process and best practices for working with
frames so you can do it quickly - and then
get on with the fun stuff of drawing comics.
If you're about to do a 200-page graphic
novel, it's important to be consistent, so
from the outset you'll want to establish
some rules. I've always preferred a solid
5mm gutter around my frames, with a
border thickness of 1.4mm. These are
pretty much the standard for 2000 AD.

Chaos, destruction, panic, all
contained within a mix of full-
bleed and overlapping panels
built within Clip Studio Paint.

When you have a monster too
large to be contained in the
frame, that’s when you may
need to have it burst out!

Step-by-step: Making the most of frames

Frame 1

B'\DU‘NOM'I.I

[ e
In Preferences>Layer
¥ Frame, set the Frame

-Bo_']jder Horizontal Space and

Vértical Space to 5mm each.
Clip Studio Paint uses the 5mm
both as a default and a guide
when moving frames close to
each other, but you can adjust
individual frames to overlap
them or alter gutters. (If your
measurements aren’t in mm,
change that in Preferences>
Ruler/Unit>Unit Of Length.)

.
Select Rectangle Frame,
¥ making sure the layer

selected is the frame folder
layer (if you're on another layer,

creating a rectangle frame will
also create a brand new frame
folder layer). You can now add
this new frame on top of any
other. Since Clip Studio Paint
lacks any tools for reordering
panels, though, it’s handy to
know that cutting and pasting
a frame moves it to the top.

P
.Once you’ve created a new
w” frame (Layer>New Layer>

‘Frame Border Layer), with a

border set using Line Width
(it will remember your last
used size and default to that),
you can then slice the frame up
using the Divide Frame Folder
tool, making sure it’s set to
Divide Not Folder but Frame
Border. Hold Shift while placing
the cut to fix the angle of cut in
45-degree increments.

[ O

Using the Polyline Frame
¥ and setting its Draw

‘Border property to unchecked,

you can now draw a frame over
the top of any other. This is
incredibly useful if you want to
add a bit of drama to a frame
by having a character punch
his way out, or even open the
top or bottom of the frame up.
The Polyline frame sits on top
and hides the frame borders of
any frames it’'s on top of.

NEXT MONTH: DEPICT BRUISED SKIN | PAINT MULTI-COLOURED SMOKE | GENERATE A CROWD
OF PEOPLE | MATERIAL PAINTING TIPS | ILLUSTRATE TOILING BELLS | AND MORE!
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The American artist tells Gary Evans why
drawing well is like telling a good joke

eter de Seve, aged 16, a student at Parsons school of art

and design, walks through Greenwich Village to the
corner of Bleecker and Macdougal Streets. It's snowing.
He finds a table in Café Figaro, the New York coffeehouse whose
past regulars include Bob Dylan, Lenny Bruce and Jack Kerouac,
where he drinks cappuccinos and draws in his sketchbook.

With his drawings, Peter’s trying to impress people - friends,
girls too. And it's during these quiet afternoons that he starts to
understand what it means to be illustrator, and exactly what it is an
illustration is supposed to do.

“It was a magical time,” the artist says. “It was 1977 when I
started Parsons. For a kid from Long Island, living away from home
for the first time, it couldn’t have been more exciting. The punk
scene was in full swing - yet there was still a faint whiff of the #»

~ oy SCRAT SKETCHES

opt - Peter created Scrat, a

sabre-toothed squirrel and

one of the stars of the Ice

P ) Age franchise. He drew
b these sketches in 2006

using wax crayon on film.

! o =z ' Peter worked on the recent 3D animated
*film The Little Prince. This drawing is a

development sketch of a “smart and precocious”

. character known simply as The Little Girl.

Courtesy of Netflix
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PETER D SEVE
66 For a kid from Long Island, living

away from home for the first time, it
couldn’t have been more exciting %9

@ 20th Century Fox Film Corporation

ICE AGE, DAWN OF THE DINOSAURS

In his character designs for the Ice Age: Dawn of the Dinosaurs, as with
illustration work, Peter strives for exaggerations that feel real and credible.




PETER’S BIG BREAK

In 1995 Peter accepted an j J AV
offer from Disney to work | £5. 577
on The Hunchback of | il
Notre Dame. It was the |~ L '{
A
i

start of a long career in |
character design. - . ,

© Disney Enterprises Inc.
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CROCODILE TEARS

This unused New Yorker cover, created in
watercolour and ink, shows Peter’s love of an
arresting image that's full of character.

»» folk scene down on Bleecker Street.
There were hardcore punks and stoned
hippies all over the place, and that’s where
friends and I spent most of our free time.
We'd walk through the snow and hunker
down at the Café Figaro.

“Tjust loved to draw things that would
amuse myself and other people. That's kind
of the job of an illustrator in a nutshell, isn't
it? It's not only about pleasing yourself but
you have to communicate to and entertain
an audience. Every drawing is an
opportunity to make someone feel
something specific and to do it in the
cleverest, most economical way possible. I've
always loved that challenge. I think I was
hard-wired to be an illustrator from birth.”

CONSTRAINED BY THE FACTS

In 1995, Disney came calling. Peter
accepted an offer to work on character
designs for The Hunchback of Notre Dame.
They didn't use much of his work, but it was

SCRAT DE SEVE

This wax crayon drawing shows sees Peter looking a
lot like his most famous creation, Scrat from Ice Age.

66 How your
audience views
your work
determines how
well you've told
the story 99

the beginning of a long career in character
design. His credits now include

A Bug's Life, Finding Nemo and all five

Ice Age film - he created the endearing
character Scrat for the franchise.

Peter says his work is as much about
concept as it is technique. He likes a strong
image, a split idea - like a lion in a vegan
restaurant. His character designs are often
about the little details that change the image
in a big way: a head tilt, an eyebrow raised.
He doesn't use too many references, because
he doesn’t want to be “constrained by the
facts.” Yet any exaggerations in his
characters must also feel real and credible.
He describes his own work as looking
contemporary, but “glazed with a 19th-
century patina.” And as a working illustrator
and character designer, the viewer is always
an important part of what he does. =+

%FILE

Peter de Séve
LOCATION: US
FAVOURITE ARTISTS: Jack Davis, Wally
Wood, Frank Frazetta, Heinrich Kley, Arthur
Rackham, Roland Topor, Murray Tinkelman

and, most inspiring by far, Brad Holland
MEDIA: Wax crayon, ink and watercolour
WEB: www.peterdeseve.com
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pla}ful character }‘ { ‘\'
based on two of the leads from
Ice Age: Collision Course,

the fifth and most recent
film in the franchise.

WILD RIDE

© 20th Century Fox Film Corporation

‘\..__ Buck, an insane one-eyed weasel,
. joined the cast the Ice Age franchise in
. the third film, Dawn of the Dinosaurs.
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actually used Peter’s characters
L% r The Hunchback of Notre Dame, but
gone on to work for box-office hits such
3 '3 s Life and Finding Nemo.
v
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(RASH

\
» “Every drawing is an opportunity
3 to make someone feel something

5\ specific,” Peter says.

»>  “Tome,” Peter says, “the viewer is the
second most important element in picture-
making, second only to the picture itself.
How your audience views your work -
meaning in which order he or she takes in
what is happening in your picture -
determines how well you've told the story.”

Peter is also known for his front covers
for The New Yorker magazine. For 20 years,
he “worked in the trenches” of editorial
illustrations, submitting as many as three
pieces each week to Forbes, Business Week
and The New York Times, among others.
He's also created book covers and posters
for Broadway shows.

He'd been at Parson for a year when he
was introduced to editorial illustration.

66 Almost all of
my biggest heroes
are artists whose
work is grounded
in reality 99

Ice Age images © 20th Century Fox Film

MONSTER TRUCKS

Peter worked on Monster Trucks,
a film released earlier this year.
This subterranean creature is,
appropriately, called Creech.

hahi

SHANGRI-LA
This hand. bunch are i
of Shangri-La, taken from last year's
Ice Age: Collision Course.

The 1970s, he says, was editorial
illustration’s heyday. He came across a book
called The Art of the Times. It contained
editorial art by illustrators “hired for their
hand as well as their brain,” such as
American artist Brad Holland.

“Man, I loved his work,” he says. “He fit
perfectly into that rubric of exaggerated
realism I mentioned earlier. But beyond his
drawing style, were images that insisted the
viewer engage with them. Not literal
solutions that simply depicted what the
article was about, but visual companions to
the written words, which made their own,
independent statement.”

EXAGGERATED REALISM

For many years, Peter worked late at night
and would stick at it until the early hours of
the morning. He's easily distracted. There
were fewer interruptions at night. After he
got married and had a family, he switched to
“a much healthier” nine-to-five. But that
doesn’'t mean he’s free of distractions.

His dream working day looks something
like this: he lives and works in a

RAT RACE

Peter says a good drawing is like a
good joke: the punchline should always
come at the end: like seeing the rat
dfter seeing the commuter.

PETER TE SEVE




WHAT’S ON THE
MENU TODAY...?

Peter reveals through his process for comin?( up
with a cover for venerable title The New Yorker

“My work often begins with a visual dichotomy of some kind. In
this case, my initial doodle had something to do with carnivores at
a vegan restaurant, the kind of place you can easily find in a
Brooklyn neighbourhood like mine. My wife, Randall, has been a
vegetarian since she was 12 and though | tried being one for
almost eight years. | realised it just wasn't for me. That moment,
when | first began to rethink my diet, is what this cover is all about.

Once | landed on the lion with a salad watching more delicious
options walk by, | began to refine the drawing. Originally, | had an
anaemic-looking lion, but soon decided on a healthier version.
After that, | concentrated on his expression. It's amazing how the
tilt of a head, the placement of an eyebrow or even the height of
an eyelid can totally change the tone of a drawing. In the end, |
wanted the viewer to hear the lion think to himself, “Hmmm.”

| don’t generally go overboard with references. | always do my
rough sketches out of my head, so I'm not too constrained by the
facts. Still, there are little touches one can discover by looking at
photos of a place he or she is depicting - the little flower in the
mason jar on the table and the exposed brick wall all telegraph
the kind of earthy, crunchy-granola vibe a place like this projects.
It also didn’t hurt to take a closer look at what a lion’s face is really
about. It’s easy to convince yourself you know how to draw a
thing, but that can lead to an over-reliance on cartoony clichés.
| like my exaggeration to be based on reality, at least a little bit, to
help me put an idea over the top.”

ANEW LEAF

Peter likes works built around a “visual dichotomy”, such as a lion in a vegan
He then develops the character, capturing details like facial expressions.

CONSTRAINED BY FACTS

Peter doesn’t use many references for his
- work. Early sketches are done in his head,
where he can't be “constrained by the facts.”
i A
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SPOTTING MISTAKES

Peter has created around 50 covers the iconic
The New Yorker magazine, but finds it
difficult to look at old work. He always
sees the things he didn't get quite right.




The Little Prince images courtesy of Netflix

THE LITTLE PRINCE
CHARACTER DESIGNS

One of Peter’s earliest
influences was Frank
Frazetta. He loves his
“exaggerated realism”
and used similar
techniques in his work
on The Little Prince.

ALK
A
¥
e

-

¥+ Brooklyn townhouse, where, second
cup of coffee in hand, he sits down at his
drawing board and waits for “exquisite,
heartrending images to spill from my pen.
Hours later, without having looked up from
my work even once, I turn out the light and
go back upstairs to rejoin my family...
None of this has ever happened, of course.”

A GAUNTLET OF DISTRACTIONS

His home studio “is a wonderful place,”
which is part of the problem. Bookshelves
overflow all around the room. Art from
friends and heroes hang on the walls. “Just
crossing the room is like running a gauntlet
of distractions. I often find myself staring at
abook or a picture, wondering what the
hell I was meant to do in the first place.”
Ideas typically come to him away from

the drawing board, during those distracted’

times, when he’s doodling in his

sketchbook or out running. He divides his

time between the two fields, character

design and editorial illustration. In both, F ' 3

PETER TE SEVE

66 I loved to draw things that

STUDY ON A SOFA

Even when shown in a
quiet moment, Peter’s
characters still exhibit life
in their expressions and
body language.

T

would amuse myself and
| other people. That's kind of
' the job of an illustrator %

his aims are similar: to create a character
or an image that’s just one or step or two
away from reality, something that’s plays
of a bigger narrative, a bigger idea,
something that drives the pictures towards
its ultimate punchline.

“Almost all of my biggest heroes, past
and present, are artists whose work is
somewhat grounded in reality,” Peter says,
“with a general respect for anatomy and
perspective, while still disregarding them
for the sake of telling a story. Or a joke.

“In my Rat Race picture, for instance,

I make dead sure that the first thing you
absorb is a lone commuter standing on
an empty platform waiting for a train.
' Idon'twant you to see the rat below
him doing exactly the same thing until

. (‘ \ ;
P the second beat. I composed the piece

so the man is dead centre; you have no
choice but to go there first.”
Peter ends with this key advice: “Just
like telling a joke or a story: your setup is
just as important as your punchline.” g
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Got an Apple iPad, iPhone or iPod Touch?
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On Android, PC or Mac?
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Issue 144
February 2017

This month, we help you boost
your knowledge of anatomy and
figure drawing. From Patrick J
Jones’s cover art, to creating
faces full of character with Julidn
del Rey, to human anatomy
advice from artist and tutor Glenn
Vilppu, this is an unmissable issue!
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issue 143
January 2017

An interview with A Song of

Ice and Fire illustrator Marc
Simonetti headlines our book
illustration special. There’s also
advice on getting into children’s
books, workshops on colour and
composition, and a look around
Tony DiTerlizzi’s amazing studio!

NO.1 FOR DIGHFAL ARTISTS
Imasime X |
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MASTER
MOVEMENT

FILM ART

Issue 142
Christmas 2016

Our film art issue includes
workshops inspired by Blade
Runner, Planet of the Apes and
Guillermo del Toro. Plus we talk
to the costume designer behind
Pirates of the Caribbean, reveal
how to capture movement in
your art, and much more!

Issue 141
December 2016

We launch our games art special
with Remko Troost’s cover art,
then we visit the For Honor team
at Ubisoft Montreal. Even Mehl
Amundsen talks anger, we see
how Blizzard hire staff, and there
are workshops on character,
vehicle and environment design.

www.bit.ly/ifxbackissues |k fim
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T WASTELAND

SCAVENGER

“l drew this as soon as | got
home from seeing Mad Max:
Fury Road. To say that this
film inspired me is quite
the understatement.”

MERMAIDS

“Sketching is my favourite

Like watching a Polaroid

stage | let the flowing lines
guide me until a character

starts to appear on
the page.”

part of the illustration process.

develop, I'm never quite sure how
a drawing will reveal itself. In this

Brian Kesinger
LOCATION: US

Brian is an Annie award
winning story artist for
Walt Disney animation

'I studios. His 20-year career
at Disney has spanned

both hand-drawn and CG animated

films from Tarzan to Moana. On top of
his film work, he’s also an author and
illustrator of several books, and he
blends his animation background with 1
the comic art form for Marvel Comics.
www.bkartonline.com
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CAPTAIN CASSANDRA

“When in doubt, draw an airship pirate
with a pet dragon.”

Feehint- Brian keunger

THE MAIDEN
AND THE SERPENT

“Just another excuse to combine
steampunk, mermaids and dragons
into one image.”

DRAZIER
THE CACOPHONOUS

“Who needs a foghorn when you have a
particularly bombastic dragon
roaming your coastline?”

U never gute swre
how 7 draving will

reveal ceself




THE
EXPLORER

“| wanted to capture
the moment of
anticipation before this
pilot steps out of her
vessel for the first time. Ill
leave it up to the viewer to
decide if she’ll be stepping
into the starry vacuum
of space or the
inky depths of
the sea.”

THE
ALCHEMIST

“I love taking
steampunk out of its
usual home in Victorian
England and infusing
its aesthetic into
other cultures.”

LORD
EARL THE GREY

“This dapper dragon always makes

time for tea in between hoarding
his treasure and desolating
local villages.”

A lot- of my tume us spent un duscuguon.
Meetungs can qv on for howrs and often
resdlt o the mase random sketches”

< ———— —_—




GLADIGATOR

“This is just one of
hundreds of ‘meeting
doodles’. As a story artist,
a lot of my time is spent
\ discussing different
. sequences of a film with the
“.\ story team. These meetings
. cango on for hours and
" often result in the most
. random sketches.”

WEREWOLF

\\ “There goes a wolf.”
N

== .
“Chapter 14 gets to
AAgar the Emotional
every time.”

Do you want to share your sketches with your fellow ImagineFX readers? Send us an email with a
selection of your art, captions for each piece and a photo and bio of yourself to sketchbook @imaginefx.com
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LOCATION: Ludwigsburg,
Germany

' PROJECTS: The Gruffalo,
' Petzi, The Amazing World of
Gumball, Trudes Tier

WEB: www.studiosoi.de

B STUDIO PROFILE

STUDIO 501

The 27-minute Gruffalo film
mixes computer animation
and miniature sets. It was
built, shot and animated
entirely at Studio S

The German animation studio has built a
reputation on skilled craft across multiple
disciplines, as Julia Sagar discovers

tudio Soi’s films were once

described as the “wooden toys”

of the animation industry,

says founding animation
director Klaus Morschheuser - and it isn't
hard to see why. BAFTA-award-winning
cartoon The Amazing World of Gumball
and stunning Academy award-nominated
short The Gruffalo are just two examples
from the Ludwigsburg-based animation
studio’s exceptional portfolio of globally
acclaimed films. So how did seven
animation graduates with no clients build
a 60-strong team and worldwide reputation
for visual innovation? And is it as fun to
work there as it looks?

# SR March 2017

“From the start, an
4 essential concept behind the
~ studio was that all founders
- had different roots: 2D,
puppet and 3D-animation,
design, compositing and someone who
can handle all the production work,”
says Klaus, who launched Studio Soi in
2003 with six fellow students from
internationally renowned film school
Filmakademie Baden Wiirttemberg.

“This was a great ground-base when
starting new projects, because we were able
to discuss things freely, and everyone could
bring in their ideas and concerns. Also,
we could decide which technique made

Pre-production
drawing, Ants by the
Platanus Tree, shows
Mouse from The
Gruffalo walking
through the forest.

the most sense for each project and who
could handle it best.”

This ethos continues to run through the
studio today. “We take all feedback into
consideration while working on the films
- everybody from interns to broadcasters
can contribute to the creative process,” says
Klaus. “If somebody has a good idea, it’s
always worth listening.”

“Everyone’s opinion is valued. No one is
confined to their own work or expelled
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STUDIO SOI

A still from Petzi. “Going
from desolate desert
one episode to a jungle
floor in another is
exciting,” says art
director Domareen Fox.

-

Everyone can
\. '3 /(’ %, bring in their ideas
,_/ r and concerns
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A rendered, final ; )
version of two Trudes —

Tier characters. “All of
Soi’s productions are o=
very story centred,”

says Massimiliano Truzzi.

Studio Soi developed Petzi by using character
sheets to explore different poses.

Petzi art director
Domareen Fox busy
at work in Studio
Soi’s friendly, open
studio space.
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Petzi’s Turtle Island episode was awarded
the silver gong for Best Animated Series
at the 2016 Xiamen International
Animation Festival in China.

g

'

AL/ L/
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from the entirety of the production

pipeline, just because they're hired for one
project,” agrees art director Domareen Fox.

Domareen’s currently
working on the studio’s first-
ever in-house children’s TV
series, Petzi, which is based
on the Danish comic strip
Rasmus Klump, by Carla and Vilhelm
Hansen. The budget and deadline are
tight, she says, but her team are incredibly
inspiring - and having production entirely
in-house makes communication both easy
and efficient. Her team uses a Shotgun
pipeline to take care of asset management,
but the open working space means staff can
simply walk over to each other’s desks and
chat. “We're all very well informed on
production status,” she says.

# &SR March 2017
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Before working up a
detailed model sheet,
Studio Soi made sure all
Petzi characters
matched the

director’s vision.

“People flock to Soi
to work on Gumball,
and then happily
merge into the other
projects we have,”
P says Domareen.

Working this way is a harmonious process,
and the directors usually find themselves
understanding their characters more

Like all processes at Studio Soi, aspects
like character development are a
collaborative affair. “It’s super important
that the directors know who their character
is, or who the character wants to be,”
Domareen explains.

She begins by researching “archetypes,
personality and costumes”, before tying her
research in with inspiration taken from her
own life experiences. Rough sketches are
then created in Photoshop, with Domareen
discussing the designs with Studio Soi’s
directors every step of the way. “I can't

always envision a character just from one
briefing,” she adds. “Working this way is
a harmonious process, and the directors
usually find themselves understanding
their characters more through the
exploration process.”

For animation supervisor
Massimiliano Truzzi, Petzi is
the most rewarding project
he’s worked on since joining
Studio Soi in 2012. “Being
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Beautiful preproduction

colour work for The

Gruffalo, created by
Studio Soi’s Neil Ross.

The character animator is
Studio Soi’s latest recruit

How did you get your job at Soi?

| applied in October 2016 and got
the job one month later. | saw shows
they did on TV back in the UK - like
The Gruffalo - and loved them. Plus
there was the chance to work in
another country for a while.

What does your role involve?

I’'m one of the 3D animators, so

| move the characters on-screen
around. I'm working on a children’s

Also from the pre- CG TV series. The team are a few

production stage, this episodes in, which is great because
drawing by Studio Soi’s it enables me to get a feel for the
Manu Arenas shows the style of the show.

foxhole in The Gruffalo.

What’s the most challenging part
of your job?

I'm infamous among people I've
worked with before for pushing
poses on characters to the absolute
limits, and making characters look
a bit over the top. It’s great for big
cartoony things, but this show has
real charm to it, which is helped in
no small part by the subtle character
performances in the animation. So
I'm really trying to work on simple,
smaller poses for characters and
attempting to get an audience’s
reaction from that.

What’s it like to work at Studio Soi?
It’s nerve-wracking - everyone here
is so talented. | feel like I've won a
competition to be working here. But
the staff are some of the friendliest
people you'll ever meet. Everyone
has made me feel so welcome, which
is so important, especially when
dealing with the culture shock of
moving to a new country for a job.

What sort of training have you
undertaken so far?

The supervising animator here has
gone through the shots with me,
easing me into the style of the show
by doing a few test shots. He's
already teaching me a lot about
the power of more subtle, subdued
character poses when animating
characters. He’s also really helped
to show me what an animator can
do to retain quality animation, but
to do it with speed, which is always
one of the most important things in
a show like this.

What advice would you give to

a young artist wanting to work
somewhere like Studio Soi?

I’'m trying so hard not to sound like a
cliché, but honestly: work hard, have
fun animating and let that show in
your reel when you apply. Studios
get hundreds of applications and
there’s a load of competition, so it’s
a huge help if you can stand out
from the crowd.

Trades Tier is animated in When not working on Studio
Maya. All characters are in Soi's new stopmotion-style CG
SDiwithiaivery flat shading, . TV series for kids, British
wiile 22 e TS S character am‘mati)r Ben is
most props are drawn in . -
OBland plton several getting used to life in Germany.
layers in Maya. https:/[vimeo.com/user5897285
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Petzi colours keys:
low-resolution playblast
animation stills are
painted over by
Domareen Fox to give
the rendering/
compositing team ideas
for lighting and colours.

part of the production from the

beginning, I had the chance to develop the
animation style - it was great fun,” says
Massimiliano, who's responsible for
ensuring the animation is produced on
time and to the highest possible quality.

“Usually every episode has new technical
difficulties that sometimes appear
impossible to overcome,” he says. “Solving
all of these problems in such a limited
timeframe can be very challenging.” But it's
also very rewarding: “In one of the recent
episodes we had to animate a very high
number of cloth materials and ropes. The
final result is very satisfying,” he says. “I
often get the chance to learn new things.”

A design sheet with
shading references for
aship requiredina
recent episode of Petzi.

The final result is very
satisfying. I often get the
chance to learn new things
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Assistant animation
supervisorMichael Brady
appreciates the fact that every
week working at Studio
Soi presents a new
opportunity to tackle a different approach
to animation. “One week we might have a
character that moves in the style of eight-bit
computer graphics. The next week, it'll be
a character who moves like a traditional
animated feature film,” he says.

At the moment Michael works on Gumball,
Cartoon Network’s multi-award winning
children’s animated TV series. Marked by
its lack of stylistic unity - characters are
created using everything from stylised
traditional animation and puppetry to

CGl, stop motion and live action - it's a
fantastic representation of the studio’s wide-
ranging expertise.

Compositing artist
Vincent Meunier
working on The
Amazing World
of Gumball.

A typical day at work for Michael might
involve handing out scenes to the team,
briefing them on the director’s instructions
and then putting together edits of the
episodes. He'll also work on scenes at the
2D clean-up stage of production. This is
when Studio Soi receives rough animations
from its production partner based in
London and uses this to create final
drawings for each episode.

“I've learned a great deal about
composing characters clearly within the
frame, and keeping continuity between
scenes,” he says. “These experiences in
sequential storytelling have continued to
feed into my personal work.”

Self-development is actively promoted
at Studio Soi. Creatives are encouraged to
pursue their hobbies and interests, while
senior artists are always on hand to help
junior members of staff.

“Some people come into the studio at
weekends just to learn new software or
work on their personal projects,” says
Domareen. “And the awards just help to
keep us all pumped.”

“For us as a studio, it’s essential to bring
great talents together to create something
fresh and new,” adds Klaus. “We're always
looking for new talent who want to achieve
something with us, and who will bring in
new ideas to enable great projects.”




The Gruffalo.
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See page 6 now!

Workshops assets

FOR DIGITALARTISTS | f are available...

Download each workshop’s WIPs, final image and

brushes by turning to page 6. And if you see the video
workshop badge, you can watch the artist in action, too.

Use a character
to tell a story
With an animation vibe and
an emphasis on narrative,
Kenneth Anderson creates
a fun illustration.

Core Skills:
Rebelle - part 1
Martin Hanschild introduces
the software’s main tools
and edits the workspace.

The art of
storyboarding
Honin; %(your storyboard
craft is key for any animation
project, says Matt Jones.

Concept design
techniques
Learn to think like a visual
development artist, with
industry insight from
Armand Serrano.

Combining sci-fi
noir and fantasy
Follow Alyssa Menold
as she works with an art
director for Shadowrun.

Sculpt your
concepts in 3D
Join John Mahoney for a
new series on using ZBrush,
featuring an alien pilot.
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USE A CHARACTER
TO TELL A STORY

Kenneth Anderson creates a fun, character-based illustration .
with an animation vibe and an emphasis on a clear narrative

Kenneth

Anderson
LOCATION: Scotland

Since 2005,
Kenneth has
worked in
games, 2D
animation and
illustration. He now
freelances for a variety
of clients as a character
designer and illustrator.

Incremental
backups

Try saving incremental

corrupt or | accidentally
overwrite it (rare, but it
can happen!) Or, if | want
to go back to an earlier
stage in the painting
process and bring some
non-merged elements
back into my painting for

rawing characters is a passion
of mine and I try to tell a
story with them in every
illustration I do. It can be
subtle or forthright; as long as there’s
some narrative in there, the audience can
relate and it brings an artwork to life. This
is important in the world of animation -
every character design I do for a client has
to have a sense of story behind them.
When ImagineFX asked me to do the
cover for an animation issue I knew I had

In depth Tell a story

to get an element of this storytelling in
there. I threw a few ideas on the table, but
this is the one that stuck. I'm glad too,
because it has some subtlety - a story
that relies on really looking at the piece.
Why is this girl not scared of the thing
casting that ominous looming shadow
over her? Her sketch reveals it’s just a
goofy, friendly monster.

My background in traditional
animation definitely influences my
illustration style. Its stylised and

¥

exaggerated, but I like to keep the colours
and forms grounded in reality. [ knew
painting this would be tricky with the
grassy background and heavy use of green
- I find colour a challenge every time
I paint. So I took it one step at a time,
getting the elements I knew I could
handle out the way and figuring out the
difficult bits as I went. My workflow is
simple but not completely linear, so this
workshop is a rough guide to how [ work.
With all that said, let’s get started!

Thinking, research and sketching
At the start of any new illustration, I mull over the brief
and consider how I'm going to approach the work. I research
anything I'm unfamiliar with and have a look at other artwork
for inspiration. With the notes from the ImagineFX team in

Refine the idea

There’s a bit of back and forth between myself and the
team while we decide on a direction and lock down the image.
It's important to get the characters and composition right at the

earliest stages. If the character doesn't feel alive in a rough sketch,
then no amount of painting will fix that! #»

mind, I rough out some simple sketches, trying to find a

editing, it’s easily done. = .. .
distinctive idea and character in each one.
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Workshops

Colour and

value rough
Once the team is happy with the sketch
I do a rough colour pass on a Multiply
layer, switching to greyscale to check my
values. I know the most prominent
colour is going to be the green of the
grass, so I base my colours around this.
Red hair and dark clothes should make
our character stand out.

Tablet input
settings

Photoshop offers a lot of
control over how yo
tablet pen interacts with
the software. However, |
find the tablet device

settings really useful and
they complement the
controls in Photoshop
nicely. Try lowering the
sensitivity input of your
stylus for line art and
sketching. Increase the
sensitivity slightly and
you have more
responsive strokes -
perfect for painting!

ESHEX March 2017
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Prepare the canvas

After some tweaks to the composition the colour rough is
approved. I like to paint at a higher resolution than needed so I
double the required image size. I create reference layers with the
bleed areas and the logo indicated, so I can switch them on and
off to get a feel of how everything is working in context.



In depth Tell a story

Brush Presets

Brush Tip Shape
@ shage Dynamxs

Scattering

Texture

Dual Brush

Color Dynamics
Transfer

Brush Pose

Nose
Wet edges
Buid-ug

8 smocthing

& B B Eb B B BP B B BP Bb BD

Protect Texture

&
Flip X Jither
Brush Projection

i

Create grass brushes
Before painting, I create some quick grass brushes. I want

to use my own so they’re consistent with the overall style of my Red underpainting

artwork and have a more hand-drawn effect. They don't need to I start painting from scratch with a default Pastel medium tip brush and using my

be perfect - just good enough so I can quickly lay down some colour rough as a guide. Because green will be a large percentage of the image, I plan to paint
texture and then paint over the top. I have supplied these on top of a reddish underpainting. I want the red to shine through so the green is less harsh -
brushes with your resources - see page 65. atip I learnt from James Gurney’s book, Color and Light.
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Background block in

Using my custom brushes and a default Pencil brush I
layer in the grass. I'm careful about where the grass is in relation . -
to the magazine cover text and where it leads the eye: I want the Bring in the characters

e

viewer's attention to be on the characters and not on the blades I copy the characters from my colour sketch and put them on separate layers. [ have to
of grass, after all! I use Hue Jitter (in the Color Dynamics section  be careful I don't lose their energy as I paint them up. Using the rough characters as

of the Brush dialog) so that the colours vary. I'm keen for some underpaintings, [ start to block in their forms on a clipping mask. This enables me to paint
yellows and blue-greens to be in there. without destroying the original layer information, merging the layers when I'm happy. #»
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Continue the block-in

I do a rough pass of everything, focusing on good values and getting colours that work
together while avoiding too much detail. I throw stuff out there and see what works, painting
until things start to feel right. I separate elements on to different layers: the flowers, shoes and
jacket have their own layers. It makes them easy to move things around.

Cl:eate/release
cllpping Mmask
cmd-:-OptiomG (Mac)
: Ctri+Alt+g (PC)
Quickly mask the chosen
layer with the one I

that’s below jt.

Treating the shadows differently

I keep the main character and monster shadows on
separate layers and start painting in cool hues to suggest the
reflected “off screen” blue sky. I minimise details in the shadows
and ensure that they're strong enough to suggest a sunny day.
I set the main monster shadow layer to Multiply, but the girl’s
shadow is painted on a Normal layer because it doesn't need to
interact with a complex background.

¥

Use greyscale

to check value
With a Hue/Saturation
layer set to zero

e

can quickly turn your
colour information
distracting me. Try

retaining good value
structures and forms

while | colour.
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With everything roughed out I start to render the forms, using the Color Picker tool to choose colours from the canvas. I try to
bring the colours to life by adding subtle reds into the face and hands, reflected light from the grass and more cool sky reflections in
the shadows. This is an ongoing process throughout the rest of the painting process.




Overlay some yellow-greens

Once [ have most of the elements in place, [ add an
Overlay layer on top of all the layers and paint in some yellow-
greens. I find this helps to bring to life the glows and transitions
between shade and light. I switch this layer on and off while
painting, so it doesn't interfere when painting on other layers.

EY

[ Preserve Luminasty

Final polish

I get stuck into tightening up the details and making the
changes requested by ImagineFX. I'm careful not to get too
carried away with details because I want the image to maintain a
looseness. I refine my Overlay layer and create a colour
correction layer: my image is very green and I want to balance
things out with some subtle reds. I also adjust the sight line of
the girl’s eyes so that it’s clear she’s looking at the tip of her pencil
to help her complete the sketch of the friendly monster. g

In depth Tell a story

More rendering and tweaks

By this point the major elements of the scene are mostly complete. I just need to
tighten up forms and details and change any bits that I'm not happy with. I introduce more
grass details, work into the flowers and adjust some colours in the faces of the girl and her dog
before sending it to the ImagineFX team for final feedback.

PHOTOSHOP

CUSTOM BRUSHES:
GRASS A

A simple brush | created

and used to quickly
suggest grass while
maintaining my usual

drawing style.

CHUNKY CHARCOAL

My go-to brush for

www.kylebrush.com.
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Workshops

CORE SKILLS: REBELLE
PART 1 TAKE A TOUR
OF THE PROGRAM

Martin Hanschild starts his series on Rebelle by editing the workspace
and introducing the main tools of the natural media painting program

Martin
Hanschild

LOCATION:
Czech Republic

 Martinis a
| 2D and 3D
character
[ designer who’s
working for
Eallin, based in Prague.
www.hanschild.com

Control the
canvas view

To enable me to quickly
alter how | view my art,
I’ve configured the

left cursor arrow to
rotate the canvas
counterclockwise, while
the right cursor rotates it
clockwise, up activates
full screen mode, and
down to flip the canvas.

ebelle, from Escape Motions
(http://ifxm.ag/rebelle-em)
mimics the behaviour of
watercolour, acrylic and dry
media digitally, using real-world colour
blending, wet diffusion and drying times.
You can paint on wet or dry surface,
control the bleeding of colours, make
your colours flow by tilting the canvas,

and even blow on wet washes to change
the direction of the spreading colours.
You can also use a drying tool to remove
water and stop the flow, and alter the look
of your art by choosing different papers.
Rather than being packed with features
that are rarely used, Rebelle focuses on
the painting experience. What I love
about the program is how it encourages

experimentation on the canvas, resulting
in numerous happy accidents.

Painting in Rebelle is a different
experience compared to other art
programs, because of how it simulates
traditional media. In this series I'll show
you all aspects of the program, and how
to use its tools. Let’s start by configuring
the workspace and the key tools....

Prepare for painting

This menu pops up when you
launch the program. Choose from
common paper sizes or define your own.
You can select the canvas background, too
- you can change this any time during
your work. Then press Ctrl+N or click
File>New to create a new document.

-

Ve

Fl(;/: the canwas orientation here.

Guve your defined canvas siz¢ a
MVM and. click. + tv add, -
v a lue of preset caryases.

D{/MMW o the DPI value it
set, puetwre size wfsrmation will

¢ ﬂvtﬁrwwzﬁm@ calelated both
e centumetres and, inches.

Navigator
Wil

Color and
Color set optLng.

Layers are
shown here.

Drag and, d/ro W\f%& o tr the

caryas from the F

/\/\f{Mj&”

Picture Size:

Width: 2.25

Height

Setting up your

workspace
This is the default workspace (left). The
GULI is simple, readable, and you have all
the necessary tools to hand. Panels are
dockable, you can change their position
and size, and attach them or let them
float freely. Here I've docked all panels on
the left, except for Color and Navigator.

Click. the edge and drag tv resize
a /W:ML if o want v recurn
tv the defanlt workspace, select
MenOW ndesReset tr defanle.

Picture Size Info:

Click the pantl name and drag
tr mave ot arnund.




Core skills Introduction to Rebelle

Exploring the panels

There are seven panels in Rebelle: Tools, which contains several
types of brushes; Properties, featuring brush and tools settings that
may differ in their properties; the Color and the Color Set panels; Tilt,
which determines the direction and speed of running colours;
Navigator; and Layers, which enables you to manage your layers.

Brushes, From lefe tv ry/w Watercolor, Ap(ylw, Pastl,
Pencil, rmkfm, Marker, Avrbrah and Erase.

\\Twl; From lefe ¢v right Blend, s ~
; - , ¢, Water,
Ory Indu/Redn, Eﬁv%, Color P(pkg% Trangfurmn.

Thu merun contawng different weund Tor each pandl.

You can hide all Panels tfﬂ presivng Tab.

Under the Color Palette
men yon can SWite
between a circle (the classic
color wheel) and a square
coloar palecte, show or hide
sliders, and chowse ¢ither an
RGE or HSL colmur madel.

Drag the lietle curle
the weer ring tv adjust a
colowr's Hue, and the circle
wnslde a square tv alter

Satwration and Lg/»/mm.

The black box in the Navigator Click the Navigatir Mem and
corresponds tv the currently switch tv_greyicale (G) tv check
viewable area in the window. yoar unage's values.

The Navigator panel

I use the Navigator panel a lot, mainly to preview my work-in-progress image on
a second monitor. Within the Navigator panel are options for Viewport zoom, Rotation
and Flip, but I recommend setting up keyboard shortcuts for these operations.

The Tilt panel

Tilt affects the movement of wet
paint and is represented by a circle with a
pointer. Click and drag this pointer to set
the angle of the canvas, while the length
of the line determines the angle and
speed of the running colours. Click the
middle circle to turn Tilt on and off.

Set your Preferences

Under File> Preferences there are
several settings that I recommend
configuring when you first launch the
program. Go to the General tab and in

B select last paint brush when color is picked from palette the Interface you can resize the whole

[] Show wet layer when using Water or Dry tools

Strength

interface. You can also set custom
keyboards shortcuts under the Keyboard
tab. Not all of Rebelle’s tools have
shortcuts, so it's good to set your own. f

Cmanth your paLnting strekes mare
[é’y (/Mrﬂﬂﬂzw f’/MJ /MmWf’er.

i yoire working o
a'tablet that has an
accelerometer, your canvag
et can e conerolled fy
_yr tablet's oreneation.

Exclusive subscriber offer!

Get Rebelle when you
subscribe! See page 36




THE ART OF

STORYBOARDING

Matt Jones passes on his industry experience for honing
your storyboard craft - a key skill for any animation project

Matt has

worked in the

animation
industry for

over 20 years
~ and storyboarded for
major studios including
Aardman and Pixar. He’s

currently in Los Angeles
developing projects.

http://ifxm.ag/m_jones

uring the early months on
Pixar’s Inside Out, I gave
myself a personal assignment
to draw a sequence from the
point of view of an adolescent girl
running away from home after an
argument with her parents.

I had recently moved to San Francisco
from the UK and based the sequence on
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my exploration of the Bay Area. She
followed a path across the Golden Gate
Bridge through Sausalito, Marin and up
to Point Reyes lighthouse - the edge of
her known world. I could see a parallel
with the interior story of the Emotions
lost in the Mind (at the heart of the film).
I was trying to find symbols that could
have corresponding interior imagery: the

lighthouse as a beacon of joy, the Golden
Gate Bridge spanning two worlds, the fog
that hangs above Twin Peaks.

I drew the sequence rapidly in a flurry
of inspiration, on paper, but then lost the
originals. I've recreated the sequence
digitally, taking more care over the
drawing. They're ‘beat boards’ - single
panels to represent a scene. B
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1GETTING STARTED

Faced with that first blank panel, where do you begin?
Well, think! Read the script pages multiple times and
visualise the sequence in your mind. Start sketching
key images or shots you think are integral. It may be
an establishing shot of the location or the height of the
emotional beat of the scene. For a complex setup with
multiple characters moving around, a good idea is to
draw a map with camera placements to stay on track.

6 The orientation of the face towards
the camera can determine the level of
empathy the audience feels 99

3 STORYBOARD BASICS
Contemporary feature animation
boarding usually requires several
panels per shot. For instance, if a
character is moving out of frame
from a standing position you would
have an A pose (standing), a B
pose (walking out), and a C pose
(gone). For the purpose of a
smooth animatic the editor might
demand some in-between poses,
for example, an anticipation pose,
before the walk and a half-out

# ESHEX March 2017

pose as the character exits the
frame. This is where modern
storyboarding converges with
old-school 2D layout and even
approaches animation. It depends
on the wants and needs of
particular directors and editors, but
often story animatics or story reels
feel animated. They may be roughly
drawn but are so fleshed out they
feel animated, which helps the
audience read or follow the story.

2 GET THUMBNAILING

Thumbnail sketches are ‘thinking’ drawings and help me
quickly work out the staging and acting of a sequence.

| won't start a sequence until I've fully thought it through
and know where I'm going with it. I'll improvise acting and
poses once | get into boarding, but | need this framework

to support the sequence and ensure it flows with the right
camera angles, moves and cuts. | usually thumbnail on the
script page, roughing out compositions and circling lines of
dialogue with speech balloons attached to the relevant shot.

4 GENERATE EMPATHY

The orientation of the face towards the
camera can determine the level of empathy
the audience feels with that character. A figure
in profile reveals less of their face, shows only
one eye and therefore we see less of their
emotional state (although it works for a
detached or cold state). The Pixar style has
evolved to have characters virtually full face
with their eyeline just left or right of the
camera. (The characters in Cars needed this
because of their wide facial designs).
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space in two dimensions U D <
by having characters at
different scales within the CAMERA

frame, or overlapping

them to delineate size

differences. Use

overlapping objects and 6 MAINTAIN EYELINES
architecture too. Characters Screen direction must be adhered to. If character A is talking to character B then A must face B

advancing to or recedin_g and those eyelines should be maintained. Character A shouldn’t be looking in the same direction as
from the camera also give character B when they're talking. If both characters appear to look screen left then one of them has
the illusion of 3D space. broken the 180-degree line, and the viewer will feel they’re no longer addressing each other.

7 BUILDING TECHNIQUES

Story artists should not only be good at tackling character
expressions, but must also be adept at environments, the 8 BODY LANGUAGE

backgrounds of storyboard panels. Sketch from life and I love to tell stories visually, with as little dialogue as possible. It's the
familiarise yourself with different architectural styles to build  unigue power of cinematic storytelling and | relish the challenge of
a mental library of designs. Study principles of perspective communicating narrative through drawing alone. The drawing above
and use it to dynamic effect in your boards. Low or high became an exercise in expressing emotion through composition,
angles on buildings tend to look more cinematic. framing, body gesture and facial attitude.

9 MAKE GOOD USE

OF LIGHTING

| like to indicate lighting

to add a sense of mood
and tone. To do this quickly
(story artists must work
fast these days to hit

short deadlines), | start

all story panels on a grey
background, from a
template. | use lighter greys
for skin tones, white to
highlight eyes, clouds, teeth
and dark greys to balance
and black for contrast. (This
means a white background
can be used, for startling
effect, when required). =
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10 AIM FOR INTERESTING STAGING

Dialogue scenes don’'t have to be characters standing around. Decide if
it might serve the scene better to have them move around. The staging
can help you express who has the power in a scene - who is dominant.

Power can shift within a scene or a shot as characters become small or

large elements within the composition.

# ESHEX March 2017

11 BIG OR SMALL?

Size relationships can influence the emotions of the
audience or reveal a character’s psychology. A very small
figure on screen can seem lonely or overwhelmed by their
environment. If the horizon line is at a low angle, a character
can feel dominant over their environment or heroic, even.

¥,

12 LEAD THE EYE

In storyboarding, you're leading the eye with contrast.

The viewer’s eye will instantly go to the point of highest
contrast. Use white against black, in shape terms, straight
against curve, or negative against positive. Our brains are
hard-wired to detect contrast and it’s aesthetically pleasing.
Contrast is dynamic, communicative and cinematic. Don’t
be afraid to use heavy blacks - think like a camera operator
and create drawings that feel like frames from a film.

13 MAKE YOUR
SHOTS COUNT
Close-ups can be reserved
for impact - don’t make
every dialogue shot a
close-up. Remember, the
characters are large on a
cinema screen. An intimate
close-up of a character’s
face is only really necessary
for very subtle shots of
emotional resonance, to
show someone thinking,
changing their mind,
realising something, shock,
surprise and so on.

66 You must
suppress artistic
ego. The drawings

are entirely
disposable 99
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15 BOOST YOUR SKILL SET

Storyboard artists are the director, must suppress ego - drawings are
writer, editor, actor and functional and disposable. They
cinematographer of their will never be seen by an audience
seguences and must be skilled and sequences are routinely re-
14 THINK ORGANICALLY in all. Reading books on these drawn or ‘fixed’ by others. It's the
Story artists must also think about how separate shots subjects is essential, but to master ideas that count and that make it
work together across a cut. When viewed in animatic form, it you must practise it. You have to to the screen. Film-making is a
shots must flow organically and also lead the eye between get comfortable with producing collaborative art form and the
different compositions. If the point of interest is screen right hundreds of drawings every week reward is the final film. Though
in one shot, then the next shot should pick up that same eye  for the duration of a production, there’s still a thrill to be had if a gag
position and lead it onto the next shot. many months and often years. You of yours makes it to the screen!

-
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17 PRACTISE DRAWING GESTURES

Along with cinema studies, gesture drawings are crucial. A regular session
in the life class with a model striking quick poses (between 30 seconds
and one minute) will loosen you up and prepare you for working as fast
& PONT 0o THIS, HES MOT. . as storyboard artists need to. It’s like the gym for your brain and arm!

¢ 2t
az )

L

18 FURTHER READING
Study film, but also read. There are many excellent books on film theory
and film-making. These are some of the quintessential reads:

SCREENWRITING 101

ALL THIS MACHINE OES v
15 sWAM ANp EAT 4 { ,L/\"
\ T r

A GATIVG MACHIVE . e LITTLE SWARKS. 7

L& P 5
T e o ik B
Reee\ 22
LY

16 DRAW FROM FILMS s >
Analyse a scene that strikes you from a good film and -
sketch the composition. Then take note of the camera on Falm~way‘ Intr the Wouds, Sereerwrtting 101, On Durecting Film,
moves and look at how it cuts to the next scene. Learn how An Introductiom tr Johin Yorke. Fulm Crue Hulk! David Mamet.
and why the sequence is effective. Analysing bad movies the Craft of the
can also be productive - notice how the film-making could Durector, Alexander And ﬂ@yﬁhg o Sidngy Lumet, Naleer Murch, Bully wilder,
have been better and think of alternative solutions. Mackendrick. Orson Welles, Hitcheock and kurmsawa. Watch and seudy theur filmy.
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ON SALE

MONEY SPECIAL: Master your financial future today!

Boost your clients’ profits, get a pay rise, budget smarter, and more...




Next month in... '/ U
lNO. 1 FOR DIGITAL ARTISTS -

Magiiie

Make your art soar with
our tips, techniques and
advice on sequential art!

Ly
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Wonder Woman
Liam Sharp and Laura Martin

reveal how they pencil and
colour a Wonder Woman page.

/7 Bill Sienkiewicz
i ,, The legendary Elektra comic
/ ,/ ,’,,-f,/ i artist on how to be unique.

ISSLUE 146 ON
SALE IN THE LIK
S FEBRLIARY

/ And much more!
i From how to use photos to
create tanks for a comic, to
creating pages in watercolours!
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TECHNIQUES

Armand Serrano on why a visual development artist is a developer,
designer and draftsman, when creating believable worlds for animation

Armand

Serrano
LOCATION: US

1 Armand has

been an
animation
professional
for 26 years
and is currently working
at the Walt Disney
Animation Studios
as a senior visual
development artist.
http://ifxm.ag/arm_ser

he main task of a visual
development environment
artist working in animation
is to conceptualise, design
and execute a believable world for
characters to live in. But the success of
these environment concepts doesn't rely
solely on the drafting skill level of the
artist. It's the whole package that makes
the final product work effectively. I'd say
the goal of the visual development artist
is to become a developer first, a designer
second, and a draftsman third.

A developer is a thinking artist — an
artist who can plant, cultivate and harvest
an idea or concept that supports the
visual foundation of a story. To become a
dynamic designer is to cook those ideas
and concepts until they become integral
visual ingredients of the story. For the
artist to become a prolific draftsman, one
has to execute and flesh out those visual
ingredients for public consumption.

Visual development is simply the visual
design evolution, from an idea to the final

product. It's how the story is handled by
p

T1CONCEPT ART =
CONCEPT + ART
Concept art is not just
about the epic, or its
beautiful execution. It’s
artwork that grows out of a
design process, well rooted
in an idea that supports
the story. The priority of
concept can be identified
thus: needs and wants.
What the story needs has
to be conceptualised first.
The artist then provide his
design wants that focus
and support the story.

@ RIGHT: The concept/idea need
for this image is to design an Asian
fairy and her magical environment.
A second character is a design
want, to exemplify the scale and
dimension. The design choice of
the secondary character creates

a relational affinity and familiarity
between the two.

® LEFT: The story is based on the
ancient Chinese legend about

Hua Mulan who once saved their
kingdom from a Mongol threat. The
need is a scenario when she puts
on armour for the first time while

in deep contemplation. The overall
design execution was part of the
design wants, based on research.

wl )

CONCEPT DESIGN

the artist(s) working on the project, going
from the initial preproduction stage to the
breaking down of the environment into
smaller parts for others to work on. So it’s
crucial that the structural makeup of the
artworks in development occur in this
order - concept, design and technique
- and not vice versa. To think technique is
the key to the success of the artwork is
totally missing the mark.

Here are my key tips that point towards
a successful process in creating strong
concepts and compositions for animation.
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2 DYNAMIC RESEARCH

Research breeds authenticity in the design evolution, from
concept to the final product. Similar to the old adage about
knowing the rules first before one can break them, | have to
learn what'’s real before | can design, or redesign, an object
or environment. Research gives a vision of functionality.
What makes it dynamic is when | start sketching and
creating thumbnails while doing research. This keeps me
from getting bogged down in reference material. | trust my
artistic instincts when | hit a design target from reference
materials, and | stop looking for more and start sketching.
My approach towards design improved by doing this.

N s

I
-

3 THINK INSIDE BEFORE OUTSIDE THE BOX

As visual development artists
and concept designers, we're
always told to think outside the
box. But | believe this is only
possible if the designer knows
what’s inside the box. And not
only to know what’s inside, but
also understand how those
objects inside the box work.

I've learned over the years not
to go outside the box if what'’s
inside it still works. At the end of
the day, it's how the story/idea
could be told more effectively
that influences your design

choices, not whether it’s a safe
or ‘out there’ idea.

These quick sketches give me
two spring boards on retelling
the story of the Titanic. The first
image is the inside-the-box
translation, with a literal narrative
of its present underwater
situation. Alternatively, | can go
for the outside-the-box option
by creating a juxtaposed
imagery of its supposed
description and its present-day
situation, encapsulated in a
classic ship-in-a-bottle setting.

4 DESIGN LOOSELY

One key discipline I've learned over the years is to design
with my arm and draw with my wrist. There’s a dynamic
balance of freedom and control in my wrist, and a
dynamic balance of freedom and control in finding the
right design language when the arm is moving loosely.
When | become lazy and miss the arm out, the artwork
tends to be static and lifeless. These images (left) are
from a 90-minute demo process in a live workshop. The
18x24-inch canvas gave me a good amount of arm
flexibility. Then | took a hi-res iPhone photo and
transferred the file into Photoshop for value and colour. =+
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S UNDERSTANDING COMPOSITION

Getting to grips with composition
is vital to the structural strength of
design. Composition is not just a
standalone term that simply
describes an arrangement of
forms and shapes. Instead, realise
that composition is perspective,
value, staging and colour arranged
harmoniously, to tell the story or
idea more efficiently.

N
AN

Perspective is the placement of
the camera and what type of lens is
being used. Value translates the
application of lighting. Staging is
the arrangement of different
elements in the canvas using the
combination of shapes, sizes and
overlaps, creating depth, dimension
and balance. Colour is the harmony
of palettes and temperatures.

6 VISUAL AESTHETICS USING PERSPECTIVE
Perspective has a strong psychological effect on viewers’
perception. Below, various camera placements of the
same subject and environment give different viewer

perceptions. The viewpoint is the audience’s eyes.

a

A high-angle shet suagests vwinedriiey,
Jﬁr%fk/ %nf 1 MMMZM Lmdxmw4 -

7 THE APPLICATION OF
VISUAL AESTHETICS
Visual aesthetics is the study of how
compositional elements (value,
perspective, staging and colour) interact
and the audience’s reactions to them. It’s
not enough to understand composition
and expect to be effective visual
storytellers. Rather, it’'s important to
understand perception - how the
audience reacts to composition.
Improper use of composition will result
in an audience’s selective perception.
Selective perception results in selective
context. And selective context means
the audience will have different
interpretations of the story/idea. With
the proper use of visual aesthetics, the
compositional choices become
intentional and directional towards
intended perception.

# WESHERX March 2017
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When the artist controls selective
seeing, the visual message becomes
subjective. Subjective means controlled
perception. Controlled perception results
in controlled context, and this means
the audience will have a singular
interpretation of the story idea.

My original idea for this image was to
place the male subject at the same

distance from the camera, but staged
right below the lady on the bridge. Yet this
gave the impression he'd already reached
his destination. So instead | moved him
just a little bit to the left. It gave a hint that
he’s not completed his journey, but he’s
about to reach his destination very soon. It
also helped to create a perception of
movement in the painting.



8 VISUAL AESTHETICS USING VALUE

Value is the lightness or
darkness of a colour. Every
colour has a corresponding
value and that lightness or
darkness depends on the
amount of lighting applied
to the colour. The three
important rules of value are:
a) It controls focal points -

usually the brightest area, the
highest contrast, or when a
predominant value encloses an
opposite value; b) value gives
the illusion of three-dimensional
form, when it shows the surface
being hit by light and the
surface under the shadows;

©) value creates the illusion of

Artist insight Concept art techniques

depth (altering the range of dark
and light creates distance).

The perception of mood or
emotion of the story being told
in the canvas is established by
the applied lighting translated
into values. The success of
colour composition depends
on the value composition.

9 VISUAL AESTHETICS
USING STAGING

Combining different shapes and
sizes together in a shot creates the
perception of intensity. Intentional
overlap in images also develops
cohesion and relationships among
characters and environment. The
higher the contrast between sizes
should result in greater intensity.
The same goes with shapes.

6 Effectiveness
of information

is dependent on
the shapes 99

10 WHY THE READABILITY OF
SHAPES AND FORM IS KEY
From the overall form to the least visible prop,
every shape has to be readable. Evenin a
busy setup (see left), the effectiveness of
information is not dependent on the details,
but the readability of shapes. Even if those
shapes were stripped of details to the point
of silhouette, they will still be easily identifiable.
World War |l pilots were trained to identify
specific enemy ships at sea by reading their
silhouettes. So | would say your designs must
be exaggerated and simplified, with clear
silhouettes working harmoniously. =+
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1 86 By using the less-is-more

= approach method, the designer
leaves room for the viewer to
fill in the missing details 99

11 BALANCE IN A SCENE
Imagine the subject as the pivot of a horizontal lever.
Now remember, all other elements that will be drawn
on the canvas will have “weights” that are based on
their shapes, sizes and value. Balance will be attained if
these elements are staged on both sides of the pivot,
without having the lever tilt on either side. The example
above is balanced, with the closer tram on the left
equalled by the lamp post and more-distant tram.

12 LESS IS MORE

In designing what'’s supposed to be repetitive patterns, such as bricks
on a wall, or organic patterns like rough textures on rocks, always
apply the economy of lines and simplify without the compromise of
information. This can be done through the less-is-more approach. This
is either the simplification or purposeful removal of details on some
sections. By doing this, the designer leaves room for the viewer’s
imagination to fill in the missing details.

T
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13 DON’T BECOME DEPENDENT ON

PHOTOS AND TEXTURE BRUSHES

This tip doesn't intend, in-any way, to look down or
undermine the direct use of photos in the digital painting
process. If it’'s needed in production, then go for it. But
the heavy reliance and dependency on photos should

not become a designer’s priority. Your goal is to learn
how to create simplified textural patterns and concentrate
on the design essentials first and foremost. There’s a
charm added when hand-drawn textures are applied.
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14 ADDING SOME ® When creating an island that’s
HISTORY AND STORY anthropomorphically inhabited by
Research plays a big part in this penguins, just designing from a # This is a concept design of Walt Disney while serving
process. The believability of a photo wouldn’t be convincing. What as an ambulance driver during the tail end of World War |.
world doesn’t come from a literal makes it believable is applied history To make the concept convincing, | made it black
application of a photo. The and story. Adding the two penguin and white and applied a JC Leyendecker-inspired
designer has to find a way to monuments (above) made sense in stylisation. This was an appropriate direction to take
design the history and story of an establishing the penguin world, by because he was the leading illustrator at that time. This
environment that personifies and giving a clear perception of their gives the viewers the perception of contextual harmony
supports the personalities in it. habitation of this environment. between the actual story and the style of the image.
15 LASSO PAINTING
This is the technique | use when I'm pressed for With practise, this process is very effective for a
time. | coined the name from the Lasso selection quick turnaround of art. At this point the heavy
tool in Photoshop. Its simplicity and ease of use lifting has been done and all | need to do is a bit
enable me to drop the values, carry out speedy more painting over the image to create a refined,

colourisation and paint over highlighted surfaces. | final version if needed.

Ko o

e

Thumbnail and line work

| create a very quick thumbnail idea for composition and direction, then lay down the line work. The column and the character are on
two separate layers. Then | drop and separate the local values using the Lasso tool. | also use a little bit of Airbrush to soften the edges.

Duplicating the layer Keeping lighting consistent

Next | duplicate the desired layer to be colourised, then select it. | pick the Using the Lasso tool, | select the cast shadowed surfaces. | soften the mask for
desired brush and then from the Brush Mode drop-down menu, | select Color (and the columns but keep it sharp on the character. Consistency in lighting is the key for
| make sure to bring it back to Normal mode after this step). this step. | create separate new layers for shadowed and highlighted surfaces and |

increase the cool tone, then darken the layer with the shadowed surface. | increase the
warm tones and contrast on the layer using highlighted surfaces. .
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COMBINING SCI-FI

NOIR AND FANTASY

Alyssa Menold works with an art director for the Shadowrun RPG,
working up concept iterations and going from client brief to final painting

.

PROFILE .

hen Catalyst Game Labs
approached me about doing
the cover for Shadowrun’s
Court of Shadows rulebook,
I was beyond excited.

I've always had a ton of fun with
Shadowrun's gritty, urban settings. But I
was psyched at the opportunity to change
things up and bring my love of traditional
fantasy to the role-playing game.

When I got it, the art brief described
a faerie queen walking through forested
ruins. However, Catalyst’s art director,

Brent Evans, also had a couple of key
points that the cover needed to hit. He
was looking for a strong, central figure,
one who appeared to be both fascinating
and ominous too.

As well as that, the painting needed
to have a sense of movement, and the
colours couldn't get too bright and fluffy.
Even though it was a fantasy painting of
a faerie, it needed to be consistent with
Shadowrun'’s noir atmosphere.

The most exciting part of this painting
was getting to be more surreal than

normal. Creating a dress that was made
of ravens, for example, was quite unusual
- and also a total blast.

Throughout the process, Brent worked
closely with me, encouraging me to push
this picture even further than I knew I
could. A lot of my favourite elements in
the painting - for example, the misty
magic from her fingers, the blurring of
reality at the edges of the painting - came
from that collaboration.

Anyway, stay with me and I'll talk you
through what I did and why. #»
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HOW TO DRAW & PAINT IN PENCILS OILS ACRYLICS & MORE!

PAGES OF
ART AND
ADVICE

-
GE__T STARTED!

Find out how to
improve your sketches

From taking your first steps in sketching and composition, to
painting stunning images in the medium of your choice, our
easy-to-follow guides will help you get better at creating art!

Tips and tricks to get the
best from these vibrant tools
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One imperative aspect of this image was the
sense that reality was being distorted by the
faerie. Brent and | looked at several options
before going with the Radial Blur filter (with
Zoom on). | applied it to the outer edges,
then painted over the filter to blend it in.

el
WORKSHOP
BRUSHES

Artist insight Sci-fi noir and fantasy

| used photographs of speckles on Soft Light
and Overlay modes to add random variation
to the background. | also used custom
brushes to spice up the painting’s texture.

l used the Queen’s hair and dress to add
motion to the picture. Their spiral shape also
centres on the Queen’s face, which helps to
emphasise it as the focal point of the image.

It was important to leave space at the top
and bottom of the painting for text and
formatting. | needed to design the spaces to
be interesting enough for the picture to work

without the text, but | couldn’t put any
important elements in these areas.
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SCULPT YOUR

CONCEPTSIN 3D

In part one of a three-part series on getting started with ZBrush,
discover the technigues John Mahoney uses to design an alien pilot

Brush is closely related to add all kinds of bits '’ pieces. You can
sculpting in real clay in many | duplicate anything you create and add
ways. You can start with a complex attachments effortlessly.

basic lump of virtual clay and I was traditionally trained and swore
fully realise your design concept complete | thatI'd never attempt 3D sculpting,
with all the details. because I couldn’t imagine giving up the
The main difference with sculpting tactile nature of clay and paint. But after
traditionally is that ZBrush enables you working with this program for several
to sculpt symmetrically. You can make years, [ can see the incredible benefit of
" including Lucasfilm, minor and drastic changes to your sculpting in ZBrush.
character throughout the entire sculpting Alot of the refined forms that I admire
process. Once you learn its basic tools, in classic sculpture, I can now emulate in
you'll be able to sculpt portfolio-worthy 3D, which would take me forever to do
creations in a fraction of time it would traditionally. Another benefit is I can
take in other programs. You can push and | export my images to Photoshop or even
pull virtual clay, you can carve away,and 3D print my creations.

Cleck. here Chevse 2 frgéaf
tv Select the  from the LightBox.
SnakeHok .
brush.

Choose DynaWax project

I choose the simplest shape to begin with - the sphere — which requires the most sculpting to make it into something interesting. DynaWax gives a nice feel
and look to the 3D form. I go to LightBox>Project>DynaWax 28. Click the centre of the screen (the canvas) and drag down to reveal a sphere. Before touching any
other button, click Edit to turn the object into a sculptable form. Then in the Brush menu, I choose SnakeHook to begin shaping the sphere into a skull shape.
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In depth Sculpt in ZBrush

The SnakeHuwk bruh Use the C[@EMMUP frush
/mﬂ; ot the skl f/wz/ﬂe. tv add, facial landmarks.

® 3

Shaping the basic skull structure

I choose the ClayBuildUp brush to add bony landmarks to the head shape. Sometimes I'll have a skull replica on my desk to
help out with this information. I add volume to the forehead, cheek bones and chin. I always add a lot of form to the teeth area, even
though the mouth is usually closed. Then I begin sculpting the lips on to this volume.

Posing with
thumbnails

| struggled with posing in
ZBrush for years. Most
artists can’t create
realistic and or dynamic/
cartoon-like posed
characters in ZBrush. It’s
a cumbersome task to
move one limb at a time
while trying to inject true

P(/MA/ é'h/LJ’A Mf‘MJ Ujﬂ A W\ﬂjk VV(,("/L movement into a static

. . vous pose_. The secret t.o.
the lp line. — the Mech brush. sty saad Al
® @& . -

in your sketchbook to
find the best pose to go
for. Once the pose is
chosen, it’s relatively

Defi ning the character’s |ips easy to pose one limb at
The lips are the most difficult thing to get right on the face. Once the teeth form is established, I build the lip forms up :I::‘;:;b:::;s;hy:tuthe
aggressively. I then create the clean separation on the lower lip line, and the centre crease between the lips. I use the Pinch brush to pose looks like. | tried
squeeze the lower lip line into position. I like to go over this several times with the Pinch brush until the lip becomes well defined. this and was amazed
[ use a custom-made Mech brush to create the centre separation line. I also use the Mask tool to isolate forms for more specific form flowilludinvizBro=l
B . characters became.
delineation (hold down Ctrl and draw on the form to create a mask).
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3D modelling
and drawing

3D modelling can’t
replace core drawing
and design skills. There
are no shortcuts to
becoming a good
designer. | always say, “A
sketchbook is worth a
thousand computers!” |
truly believe this. So
when you’re wanting to
improve yourself as an
artist of any kind, life
drawing and location
drawing is the best place
to test your skill level. It’s
great to strip away all the
bells and whistles and
really see where you’re at.
The great thing is, once
you improve in these key
areas, all other artistic
tasks you do will improve
significantly, too.

Placing the eyeballs and lids

To create eyes, I go to Brush>Insert sphere and simply click and drag on the location I want the eyes to be. If I don't like the
position, I press Ctrl+Z to undo and I'll try it again. I like to separate these eyes into their own SubTool by going to the SubTool menu
and scrolling down to Split Unmasked Points. Next I draw a mask where I want the eye lids to go. At the bottom to the SubTool menu
is the Extract button. I click this and then click Accept to create a lid.

Use the SnakeHomk
brush v j/‘ﬂ/%f the face.

® 3

Pushing the forms of the head structure
[ begin to search for a character in the face and head. I like using the SnakeHook brush to stretch and push the overall forms to see what character I can
make from the basic head shape. This is where the concept designing begins — my ideas of where the character is going start to take shape.
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Sculpting the character’s ears

In depth Sculpt in ZBrush

Cet ¢ars on a
je/mmﬁz ¢ wﬁTWl.

r») Q

Vs the SnakeHmk
brush tv shape the ear.

Ears are tricky, so I keep some reference by my side. I go to Brush>Insert Sphere and drag these on to the sides of the head. I then mash the shapes into a basic
ear form using the SnakeHook brush, before using the ClayBuildUp brush and the Smooth brush to refine the ear (pressing Shift activates the Smooth brush).

DIVIDER

Select Cylinder from
Promutives menm, then
click Dynames h.

Sculpting a separate neck

I start with a cylinder. Once the cylinder is dragged on to
the canvas, I go to the Geometry menu and select DynaMesh.
This turns the primitive object to something pliable like taffy
that I can stretch into position. I use the ClayBuildUp brush to
add shoulders and neck muscles. I like sculpting these elements
as separate Subtools: once the neck is finished, I can play with
the proportions to get everything to feel right for the design.

Create gyelashes with
the CurveTube twl.

Adding eye lashes

For this step I use CurveTube tool. First I adjust the fall off settings so the tube tapers off
to a point. This tool is also great for sculpting tentacles. I drag on one eyelash, move it into
position, then duplicate these as many times as necessary. The shortcut for this is to hold
down Ctrl while moving the eyelash, and another eyelash will appear. #
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Workshops

Always work

symmetrically
The key for designing
incredibly fast is working
symmetrically. You’ll be
designing as you go, but
because you’re working
on both halves of your
character at the same
time, you’re creating
harmonious rhythms.
Ninety nine per cent of
all creatures on Earth are
symmetrical, so working
this way helps you tap
into this basic concept.
Also in ZBrush, once
you move off symmetry
it’s very difficult to re-
configure your character T . .
e Building up the pilot’s helmet Introducing a helmet strap

Always save your I mask off the shape of the helmet, then go to PolyGroups, One of the most enjoyable tools in ZBrush is the Insert

Z;‘;:::s::::’;:::osing_ click Group Masked and reverse the mask. In the SubTool menu, ~ Meshes. I love dragging on all kinds of junk, just to see what
You'll no doubt want to I click Extract and Accept. I can now go the Deformation menu enhancements I can add to my characters. I go to Brushes and
return to that T-pose and adjust Smooth by Poly groups. This will give a clean edge to choose IMM Curve, then I press M to choose a belt to drag onto
I E G S E rim of the helmet and creates a SubTool in my SubTool menu. my character. Once dragged on, I click and drag onto an open

some point. . . . :
I now move the ears out to create a nice ear/helmet silhouette. section of the canvas to merge the belt with the face.

Click Deformation
and then change
the size.

Turning a cylinder into a space suit collar

I go to the Append button in the SubTool menu and click Append. I choose a cylinder and modify this with the masking took to create interesting forms.
I then mask off one area and then click Deformation>Size to enlarge the unmasked areas. [ can create semi-complex, hard surface shapes this way. I mask off a
ring-shaped form, then select SubTool>Extract to create a ring-wall form. Finally, I reposition the form to create the inner ring of a space collar.
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Mech Insert meshes are alien tech!

I 'add random insert Mech pieces to help me brainstorm
alien technology. I do this all the time with plastic parts with
real sculpture, but it's so much better to have unlimited scalable
bits and pieces in the virtual world. This approach has enhanced
my concept design ten-fold. I drag on a mechanical piece, then
scale and rotate until I get the correct position.

Final rendering with materials

In depth Sculpt in ZBrush

Vst the Clay Tubes

brush tv créace hases:

Create floating orbs for a zero-gravity feel

I love the concept of living without gravity. These floating spheres symbolise a
weightless atmosphere. .. something that’s impossible to create in the real world. I select Insert
Sphere, drag on to the head and then move off the head, so that the orbs look as if they are
floating in space. I then paint hoses using the Clay Tubes brush by dragging with my mouse.

Next month

Refining the
alien character
and enhancing
the costume.

I play with materials to help enhance my final presentation. I select one SubTool to have a certain material . Then I select the specific material I want for that
object. Now I press the M icon near the top of the interface, then I select the Fill Object option in the Color menu. You can have a different material for each
SubTool this way. Once done, I click BPR (Best Preview Render) to prep image for export. To export the image, I go to Document>Export and select PSD. #§
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Choice Award
Art resources with a five-star
rating receives the ImagineFX
Artist’s Choice award!

l Artist’s

The latest art resources are put to °
the test by the ImagineFX team...

HARDWARE . i 99 The Art of Moana

94 MobileStudio Pro Among other challenges, learn how Disney
Could the new Wacom tablet be the best artists gave personality to the Pacific

and most artist-friendly ever? But even if Ocean, in its latest big-screen animation.
itis, can it really justify the huge price tag?

. 99 The Art of Titanfall 2
TRAINING .. | Discoverthesecretsbehind the mechs,
97 Storyboarding Techniques guns and environments that feature in the
A nine-hour primer for the first and sequel to 2014’ first-person shooter.

most important stage of animation,
with storyboard artist Fred Gago.

BOOKS

98 Spectrum 23: The Best in
Contemporary Fantastic Art

It's here once again, the prestigious annual
round-up of the best in fantasy art. We see
ifits usual high standards are maintained.
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Reviews

With six different
models to choose from,
all capable of running
desktop software, the
MobileStudio Prois a
designer’s dream.

MobileStudio Pro

PURELY PROFESSIONAL Is this the best-looking, best-performing and

most amazing tablet ever? And if so, is it worth the huge price tag?

Price £1,399 to £2,749 (depending on configuration) Company \Wacom Web www.wacom.com

fter a few false starts

into the tablet PC market,

Wacom has finally
achieved its goal and
released a new tablet that’s the

answer to a lot of artists’ prayers. The
MobileStudio Pro is a fantastic piece
of kit that offers a portable drawing

device with very few drawbacks.

The tablet is reassuringly sturdy,
yet light enough to sit on your lap or be
carried around in your backpack easily.

It runs Windows 10 and desktop

programs such as Photoshop very
smoothly. Even when using demanding
3D programs, the MobileStudio Pro’s

fan noise is significantly less than
previous Wacom offerings. At the

very worst, the device is no louder than

an external hard drive.

# g March 2017

The screen quality is amazing, with
QHD resolution on the 13-inch model
and 4K resolution on the 16-inch. It
has six ExpressKeys and a touch ring,
and three USB-C ports that enable
charging from any port. The screen
does become a little warm, but it’s not
going to cook your lap, and the fans
are positioned well in both portrait and
landscape mode. The SD card slot is
great, not only for transferring files
across, but also for adding increased
storage capacity.

The Wacom Pro Pen 2 is a thing
of beauty. The levels of pressure
sensitivity are staggering: an
unprecedented 8,192 levels of
sensitivity. The screen is so thin that
parallax isn’'t an issue and pen lag is
virtually nonexistent. If all this weren’t

The power slider is
designed so that you
will never accidentally
turn the MobileStudio
Pro on while carrying
it around.

The sensitivity of the
Pro Pen 2 has to be
seen to be believed.
Even the lightest stroke
will be picked up.

enough, the pen never requires
charging. We can honestly say there’s
not a stylus on the market that can
adequately rival the Pro Pen 2.
However, the device is not without
its minor faults. The speakers are
functional, but lacklustre. The battery
life is purported to be six hours, but
after continuous use it’s realistically
somewhere around four hours. A
further niggle is that in the UK you
have to buy an adaptor for the two-pin
power plug supplied. Considering the



The Radial dial and
ExpressKeys are all
programmable so
you can tailor them
to your workflow.

All three USB-C slots
work for charging the
unit, so you won’t have
to switch cables around
when you need to
charge the tablet.

Art tools Hardware

66 The Wacom Pro Pen 2 is a thing of
beauty. We can honestly say there’s not
a stylus on the market that can rival it 9®

hefty cost you're already paying, this and your Mac/PC doesn't have a
feels a tad egregious. USB-C port, but this has to be

This small example links to our purchased separately. Similarly, no
biggest gripe about the MobileStudio stand is provided, and no protective
Pro, and Wacom’s hardware generally. carry case included.
While truly the best quality products For pricey kit that’s intended to be
available, they’re always excessively carried in backpacks, the absence of
expensive and don't include everything | such items is unforgivable. But of
you may need. For example, the course - you've guessed it - you can
MobileStudio Pro has no USB ports, purchase them additionally. The
so the Wacom Link (around £60) is MobileStudio Pro is lovely to use, but
necessary if you want to use the we wish Wacom would offer a
MobileStudio Pro as a Cintig monitor complete package for its high cost. g

As well as transferring
files, the SD slot also
enables you to expand
the storage options on
the MobileStudio Pro.

Select models include
the 3D RealSense
camera that means you
can scan an object into,
say, ZBrush and refine it
from there.

Features
W Wacom Pro Pen 2
W 3D camera
M Life-like colour and
up to 4K resolution
M Runs demanding
creative 2D, 3D and
CAD software
W Customisable
ExpressKeys
M Available in a range
of six processor,
memory and storage
configurations
M Intel-powered
M Pro-Pen 2 has 8,192
levels of sensitivity
M No parallax and

~ minimal lag
W SD Card slot and
USB-C ports

SARAH
COUSENS

Find out what's it like to use the
MobileStudio Pro for illustration. ..

How have you found the
multi-touch features on the
MobileStudio Pro?

Near perfect. Unlike other multi-
touch tablets, I've not encountered
many issues at all. You can rest your
hand on the screen and draw
comfortably without any accidental
strokes. I've only had one instance
where an option was selected by
my knuckle.

How do you envisage the
MobileStudio Pro fitting in with
an artist’s workflow?

You can use it from start to finish,
because you can work with full
desktop programs like Photoshop.
This means you could still work on
commissions if you were away from
the office for days and they would
still be the same standard.

Would you recommend the
MobileStudio Pro for everyone?
If the price were lower [ would
recommended this to all designers,
photographer and illustrators. But
because of the cost, it’s a tool for
professionals rather than hobbyists.

How do you find drawing on the
13-inch MobileStudio Pro?
Surprisingly good. Thanks to the
high resolution, Photoshop’s UI
doesn't take up too much space,
and the rotatable screen gives you

a completely different area to work
on, which stops the workspace
from feeling too claustrophobic.

Any welcome surprises?

The SD card slot! If you were a
professional photographer, you
could take a photo and start editing
it on site by transferring it over.
Small things like this make life

so much easier.

Speaking of interface ports, how
do you feel about the lack of
standard USB ports?

In honesty, it's a pain. USB-C ports
are still relatively new and not yet
standard, so it limits the Pro’s
versatility right now. Having to buy
the Wacom Link feels a bit cheeky!

Co-founder of illustration
company Cool Surface, Sarah
produces photo composite art
for magazines and clients.

www.coolsurface.com
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In Storyboarding
Techniques, Fred Gago
explains how to keep
the character position
on the screen
consistent, whatever
camera angle you pick.

Storyboard

Here, Fred demonstrates the art and
technique of creating a storyboard
before animating begins.

[nspiration Training

ing Techniques

GET ON BOARD Storyboard artist Fred Gago offers a nine-hour
primer for the first and most important stage of animation

A good storyboard
conveys the flavour

of the setting, even
though the final design
work isn’t complete.

he process of animation
starts long before any
actual animating is done.
Whether you’re creating a
short single-handed or are part of a
team, the storyboard is essential for

understanding how a tale will be told.

Animation remains work-intensive
despite all the computing power at
our disposal, so using storyboards
to figure out what works and what
doesn’t can save you many hours.

In Storyboarding Techniques,
Fred Gago takes you into the mind
of a storyboard artist, helping you

understand what your goals should be.

He starts with the housekeeping of
building a storyboard layout template
in Photoshop and assembling basic
visual reference to communicate the
flavour of the setting and characters.
As you'll discover through this nine-
hour masterclass, the point of the
storyboard is to convey information as
clearly as possible. The design of the
main character may not be complete,

Topics covered
M Gathering reference
W Making a template
W Warming up before
drawing

W Camera angles

M Character design

basics

W Showing movement
M Rendering values

M Conveying
atmosphere simply

Length
553 minutes

for example, but Fred will still be sure
to give him/her/it a distinctive look
and silhouette, so they’re immediately
recognisable in every frame. Choice of
camera angles is also key: Fred shows
you many of the most-used, although
a more systematic run-through might
have been useful. You'll also learn
how he uses elements in the scene
as framing devices to reinforce the
setting, and why he pays attention to
a character’s position within the frame.
The final major component is
movement. Static drawings can’t

always show exactly what'’s happening,

such as when a barman slides a beer
bottle along a counter-top. Apparently
simple actions like this become an
exercise in using as few frames as
possible to make the motion clear.
You could argue that Fred could
have got the basics across in less time,
but if you're patient and let the lessons
unfold, you'll find Storyboarding
Techniques a first-rate primer for a
deceptively challenging discipline. g

FRED
GAGO

Fred is a professional freelance
artist who's spent the past decade
providing everything from
storyboards to character and
creature design. His clients include
Disney, 20th Century Fox, NBC
Universal and Adult Swim Games.
Fred has contributed to a variety of
TV projects, including American
Horror Story, Arrow, Scream
Queens, Outcast and Banshee.
Currently he’s an art director for an
educational app as
well as an instructor
of storyboarding at
the Gnomon School
in Hollywood.

www.gagoism.com
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Spectrum 23: The Best | in
Contemporary Fantastic Art

BEST IN SHOW The prestigious annual round-up of the best in
fantasy art is here once more and, as usual, it doesn’t disappoint

Editor John Fleskes Publisher Flesk Price £36 Web www.fleskpublications.com Awvailable Now

or more than two decades,
the Spectrum annual has
been a showcase for the
world’s best creators of
fantasy art. Established in 1993 by
Cathy and Arnie Fenner, each
volume’s release is a big event, both
for fans and as a resource for art
directors, buyers and artists.
It’'s not exactly cheap. But you get
a lot of hardback book for your money,
in terms of its size, weight and number
of pages (308). Plus it’s lavishly
produced, with thick, super-glossy
paper that makes the images sing.
But what about the work itself? In
a word: breathtaking. As usual, the

Spectrum jury has selected 300 artists,

both upcoming and established, from
the US, Europe, China, Australia,
South America and beyond. Their
contributions, which include artworks

Donato Giancola’s
Vesuvius was painted
in oils for Tor Books.

created for books, graphic novels,
video games, films, galleries and
advertising, are infused with wit,
inventiveness, passion, imagination and
sheer talent. Proof the world of fantasy,
sci-fi and horror art is alive and well.
Work that particularly resonated
included Android Jones's exquisitely
intricate cover image (The Year of the
Ram); Annie Stegg Gerard’s evocative
fairytale scenes (Renard and the
Strawberries, and Moonlight Parade);
Guangjian Huang’'s mythical male and

66 Each artist has passed

a high bar to be included.
There’s absolutely no filler 9®

female warriors (Narcissu, and Silver
Knight); David Palumbo’s arresting
vision of a woman in warpaint (Binti);
Travis Louie’s enthralling alien (Invader
Mitch and his Dog); Audrey
Benjaminsen’s charcoal witches (The
Moirari) and Michael Whelan’s girl in a
floating globe (Her Own World). But
everyone will have their favourites, and
that’s the idea. Because each artist has
passed a high bar to be included here,
there’s absolutely no filler.

While most of the book is taken up
with the art itself, there’s a fair bit to
read too, particularly across the
opening 30 pages. These include a

Tran Nguyen’s Traveling to a Distant Day (acrylic
and pencils) earned the Editorial Gold Award.

Meet the Jury section, a profile of rising
star Victor Maury and a greeting from
Spectrum Grand Master Mike Mignola.
There’s also an insightful 11-page Year
in Review by John Fleskes (though the
year in question is 2015, not 2016).

All'in all, whether you're looking to
check out the competition, keep
abreast of fantasy art trends, or just
enjoy a lot of amazing work, Spectrum
23 is a desirable purchase.

RATING &&& & &




The Art of Moana

SEA CHANGE Learn how Disney gave personality to the Pacific
Ocean, among other challenges, for its latest big-screen animation

Inspiration Books

isney’s 56th animated

feature, Moana tells the

tale of a spirited teenage

girl in ancient Polynesia
who sets out to prove herself as a
master wayfinder and fulfil her
ancestors’ unfinished quest. Bringing
this ancient world to life involved
two big tasks for Disney’s artists:
authentically recreating the real-
world environments and cultures,
and portraying both the ocean and
lava as sentient characters.

Concept art by Ryan
Lang. The artists had
to contend with the
tension between reality
and storytelling.

These main challenges subdivided
into countless smaller problems, such
as making Maui’s tattoos animate
against his bare skin as he shape-shifts;
convincingly recreating the thick, wavy
hair of Pacific Islanders; and bringing to
life the eight-eyed bat and monster eel
of Maui legend and grounding them in
something real.

In this book, the authors detail these
challenges and how they were
overcome across 162 landscape-format
pages. At the same time we're treated
to a sumptuous selection of artwork,

from raw pencil sketches to thrilling
storyboards, stunning concept art
to finished CG scenes.

Disney’s Art of books have really
upped their game recently in terms
of the level of detail and insight: the
publishers, we sense, really want to
show how much thought, effort and
passion have gone into these films.
And this release is no exception: there’s
much to learn here, and a lot of
beautiful art to be inspired by.

RATING &9 £94&5

The Art of Titanfall 2

SOLDIERING ON The sci-fi video game’s weapons, vehicles, settings
and more are all brought together in one comprehensive volume

itanfall 2 is a first-person

shooter game developed

by Respawn Entertainment

and published by EA. It
focuses on an infantry soldier who
aspires to be a pilot of the warfare
mechas known as Titans. And this
196-page, large-format hardback
offers a comprehensive look at the
artwork behind the game.

Following a foreword by art director

Joel Emslie, it's divided into five
sections, covering Titans; pilots;

TITANFALL |2

“Heavy pilots were a lot
of fun to design,” says
art director Joel Emslie.

AR A

vehicles, weapons and tech; locations;
graphics and modelling. Each chapter
features a wide range of concept
artwork, together with brief
descriptions of the creative processes.
The highlight is perhaps the final six
pages, which feature stunning
3D-printed maguettes.

With a layout that’s workmanlike but
not inspiring, an obvious typo on the
contents page, and a failure to credit

artists clearly, this book isn’t likely to
win any prizes. We'd also have liked to
see more in the way of preparatory art,
rather than the solid diet of completed,
full-colour concept work.

That said, the work is all of high
calibre and will be of interest to fans
of the franchise or games designers
looking for broad sci-fi inspiration.

RATING &£ &
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INSPIRATION AND ADVICE FROM THE WORLD’S BEST TRADITIONAL ARTISTS
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112 Get started with oils
_ Howard Lyon shows you how.
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SHOWCASING THE FINEST TRAD

ONAL FANTASY ARTISTS

i fJay Penn
Ireland
www.jaypenn.com
jaypennart@yahoo.com
Pen and ink

Melbourne-born, Ireland-
based artist Jay fell in

love with the work of Rien
' Poortvliet and Brian Froud

been passionate about fantasy art ever
since. His work has appeared in RPGs,
novels and comics all over the world,
and he’s currently producing his
“magnum opus”: a quarterly fantasy
comic called The Circle.

“It’s my dream to see a Magic: The
Gathering card with my art on it one
day,” Jay says. “Or be featured in a
D&D Monster Manual... and something
Tolkien-related, while we’re at it.”

IMAGINEEX CRIT
“Jay’s deft
texturing gives

&  his drawings a

feeling of solidity and

entices the viewer's eye.

The closer you look, the

more little details spring

out to delight you. You
can see where all that
effort went in!”

Cliff Hope,

Operations Editor

“ COOKING WITH CTHULHU

“This is one of those pieces where
the marks you put down just make
sense and come out even better than
you intended. It’s what | look at when |
start to doubt my artistic worth. | put
my heart and soul into that whisk.”

% ARCHER
« = “I've always had a fascination with
rangers, so | went all-out with this
piece and put some pretty hefty hours
into inking it. | love drawing trees, so
this whole piece was a pleasure to
create, from start to finish.”

W g March 2017
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—+—Joe Ward

England
www.joewardart.com
contact@joewardart.com
Acrylics

Joe is a Falmouth College

of Art graduate with a

passion for fantasy and

figurative art. “I’'m drawn

towards fantasy with
plausibility, as well as a hand-made
quality of painting, which | feel lends
itself well to the medieval fantasy
genre,” he says.

Joe’s medium of choice is acrylics,
and he has a well-honed technique. “I
work fairly small and prefer a smooth
watercolour paper surface,” he explains.
“l usually begin with an unprimed pencil
drawing, initially using thin washes. |
find the quick drying time of acrylic
lends itself to glazing and scumbling,
providing quite a bit of versatility.”

“ ANCIENT WITH STAFF

“My attempt at a Mystic character
from the film The Dark Crystal. | like the
rough, mottled appearance of lichen
on stone. The window where | work
looks out on to a cemetery, so perhaps
the old headstones are creeping into
my painting here.”

"% A GOBLIN CLAN
« -« “All too often when drawing heads
like these, it later dawns on me that
one or more of them unintentionally
resembles someone | know! With
fantasy illustration there’s a sweet
spot between archetypal and realistic
renditions of characters that’s often
hard to pin down.”

“ ¥ FORESTELF

&' “When painting a character against
a background, | often returnto a

‘light against dark/dark against light’
approach. When push comes to shove
I’'m usually more concerned with
ensuring that an image will reproduce
robustly than | am with achieving subtle
shifts between elements.”

SUBMIT YOUR |
ART TO FXPOSE

Send up to five pieces of your
work, along with their titles, an
explanation of your techniques,
a photo of yourself and contact
details. Images should be sent as
300DPI JPEG files.

Email: fxpose@imaginefx.com
(maximum TMB per image)

Post: (CD or DVD):
FXPosé Traditional
ImagineFX

Quay House, The Ambury,
Bath BA11UA,

England

All artwork is submitted on

the basis of a non-exclusive
worldwide licence to publish,
both in print and electronically.

Email your submissions to fxpose@imaginefx.com




FXPosé Traditional art

L ' “Joe is modest
[@ ) about it, but you
“. @ can spot the
trained artist in his
work. As well as the
luminous colours and
classic compositions,
his paintings all read’
clearly and tell an
interesting story.”

Email your submissions to fxpose@imaginefx.com March 2017 IivESiHeRX w
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FULL OF

COLOUR

BAO PHAM makes use of the wet-into-wet
approach to create a serene image that
mManages to be colourful, too

ast winter, because it was too

cold to paint outdoors and I

couldn't use oil paint indoors,

I started using gouache. I fell in

love right away and it quickly
became my main medium. I love its
opacity and minimal preparation time. I
have a small studio space, so I have been
focusing on smaller works, and gouache
offers the compact versatility that I need.
Also, I work with minimal shapes and its
rich colours help me add visual interest
and create effective moods.

Gouache is best described as opaque
watercolour. It can be reactivated with
water, although it is a bit difficult to blend
after the paint has dried. However, since
it's not permanent, storage and cleanup
are a breeze. One unpredictable thing
about it is that dark colours will appear
lighter when dry and light colours appear
darker when dry. This makes it hard to
judge the value of a colour as you work,
but that can be sorted out by premixing
and testing colours beforehand. Gouache
is not only easy to use and set up, it also
has a beautiful matte finish, while the
colours stay rich and vibrant when dry.

In this workshop, I will focus on using
wet into wet techniques with gouache
and watercolour. Wet into wet is simply

painting while the surface is still saturated
with water. [ first learned this technique
with watercolour and I've found it’s very
effective with gouache as well. It enables
me to create smooth transitions between
colours and values. It's best used in a
single pass, considering that adding
subsequent layers will reactivate the paint
underneath and can cause muddiness.

I prefer using watercolour for soft
and delicate details, with gouache for
more vibrant and bold colours. I highly
recommend doing colour studies first
before working wet into wet. It will cut
down your guesswork and let you focus
on the manipulation of the paint.

Here, I'll cover the various ways [ work
with washes, starting with breaking up
sections of the painting to keep large areas
more manageable. I'll also show you how
to transition from one colour to the next
to create a smooth gradient, and how to
blend colours without lifting paint that
has been laid down.

Bao lives in Iowa, US. Paintin
-

‘eaturing various plant forms and rich

colour palettes. You can follow him at
www.instagram.com/baotphampg 24

March 2017  IiiaSiieRX
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MATERIALS . "
e — 1 The dr_awz_ng :
B Rives BFK paper : The subject is a girl
BRUSH lost in thought surrounded

by colour-shifting plants and
butterflies. 'm keeping the
shapes round and simple

M DaVinci Cosmotop
Spin Round, size O

PAINTS g y

. to let the colours shine. I'm
M Winsor & Newton drawing on Rives BFK paper
Gouache 9 [OETe)

with a mechanical pencil. If
the lines end up too dark, | use
a kneaded eraser to dab off
some of the graphite, leaving
a light pencil drawing.

B Winsor & Newton
Watercolours

OTHER
M Liquitex Black Gesso

P Digital colour study gl Premixing colours
At this point, | take a clear photo of the drawing, | premix my colours and test on a scrap piece
bring it into Photoshop and do a quick colour study. | of paper to see how the paint dries, as darker colours
make the most of my colour choices here, and Photoshop will dry lighter and lighter colours will dry darker. | thin
enables me to readjust colours quickly. | decide to keep down my gouache paint with water and keep it at the
the figure in shades of pastels and the rest of the elements  consistency of heavy cream. | find that this is best for
at a darker value to create contrast. working wet into wet.
_ARTIST INSIGHT.___

CREATING A

DECKLED EDGE

Start with a sheet of

VN Liquid frisket
Using Winsor & Newton Liquid Frisket, | mask off
the areas of her face that | want to keep white - mainly
the highlights of her nose, lips and eyelids. Once the
frisket has dried, | use clean water to wet the areas of
her eyes and cheeks to prepare the paper for the initial
them off. watercolour wash.

w ESeRX March 2017




In depth Colourful gradients

paper tow
be
fix it once it’s

5 Applying the initial washes
Using thin watercolour, | add drops of paint on the wet areas of her eyes. Working wet into wet enables the paint

to move and spread to create a smooth gradient. As the areas start to dry, | add more paint where | want the colours to
be more saturated. The less wet an area, the less the paint spreads.

Wet into wet :
Using the same technique, | wet her nose and lips, 7 Layermg the watercolours

staying within the boundaries of those features. | move the
paint around using a wet brush. When | need to remove
some paint, | use a dry brush to soak up the excess colour.
For a clean removal | use a piece of paper towel.

| let the paint dry before building on top of it to add more depth and
dimension in her features. | use black gesso to line her eyes. | like to use gesso
because it has the same matte finish as gouache and it won't reactivate if | decide

to work further on her eyes. 3>
March 2017  iiaSieRX #
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ARTIST INSIGHT

LOST AND FOUND
Watercolour on a well-

unwanted textures.

SURFACE PROTECTION
__Use tracing paper to rest

underneath.

Removing the frisket
| use a thin layer of paint for her eyebrows to let the pencil lines show through, adding texture. Once the paint is
dry, | carefully remove the liquid frisket with a hard eraser. | readjust the edges of the masked areas if they're too sharp.

] Colouring the hair
Once again, | wet a section of her hair, making sure
to exclude the leaves and butterflies. Starting with yellow

Sectioning Off gouache, | load up the paint and move it to the edges with

When I'm covering relatively large areas, | like to section off smaller, more my brush. | add the next colour and use the side of my
manageable parts to work on. This is particularly helpful because of the complexity brush to push the paint along the edge where they meet.
of the negative spaces. | make sure to keep the area wet as | go along. A back-and-forth motion helps blend the two colours.

W g March 2017



In depth Colourful gradients

> N

1 Blending with a loaded brush
| add more colours in the gradient and repeat. If a
section of gradient is being encroached by another, | add "2 Tackling the leaves
more paint to help it push back and be more visible. | make After her hair is dry, | work on one leaf at a time, wetting the shape and
sure my brush is loaded with paint when blending or it’ll loading it with plenty of paint. I'm making the colours of the leaves much darker
soak up pigment already there, causing uneven coverage. than her hair and face, to help separate the foreground from the figure.

~

13 Slow and steady

Working wet into wet takes a bit of patience, ] 4 Bringing the butterflies to llfe
especially waiting for one layer to dry before working on For the butterflies, I'm adding some greens to the gradient. These are not
the next. | keep the shapes I'm working on separate from found anywhere else in the painting, so it will help them stand out. I'm using the
each other to avoid the colours bleeding into each other. complementary colours of the leaves to paint the stems to create some contrast
| use a hairdryer, set on low, to cut down drying time. and help them separate the different elements.

- Dt

15 The final touches
Towards the end, | clean up all the uneven edges
and deepen her eyelines. For the finishing touch, | add
specks of colours throughout the painting to add more
movement and interest to the whole piece.
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Core skills: Oils

PART 1 GETTING
STARTED WITH OILS

HOWARD LYON launches a five-part series that'll boost your knowledge of oils. If
you've been putting off using this age-old medium, there’s no time like the present!

here’s an undeserved mystique
around oil painting that has
put up some intimidating
barriers for some artists
wanting to use this wonderful
medium. [ hope to remove those concerns
and provide a basic foundation of
knowledge to help you get started.

Oil paint is pigment bound in a drying
(siccative) oil. The most common is
linseed oil extracted from flax seeds, but
you'll also find paint bound in walnut,
safflower or other oils. The pigments are

generally the same as those found in
watercolours, pastels and acrylics.

Oil paints offer a richness of colour and
its surface allows the creation of beautiful
textures. You can paint thick or thin,
directly or use glazes. Oils can be used on
paper, wood, metal, plastic, canvas and
many other surfaces.

If you're just getting started, don't get
overwhelmed. Be patient with yourself
and recognise that it'll take a little time to
get the hang of this beautiful medium.
Don't overcomplicate it, either.

.
7 RESOURCES

See page 6 now!

To begin we'll go over the key materials
needed for you to get started. Most art
materials are sold in at least two grades:
student and professional. Whenever
possible, purchase pro-grade materials.

I find the difference in price is offset
because pro materials almost always last
longer and the paint goes further.

oward has worked as an

illustrator and art director as

well as a fine artist for galleries

nd collectors. Explore his art

A spectrum of colours

There are hundreds of colours
to choose from, but start with a basic
palette that covers the spectrum and
will give you a good mix of warm and
cool hues. Pro-grade oils will contain
more pigment, which will result in more
accurate colour mixing, and will be
resistant to fading in sunlight.

L 2207 Titanuun white
Cadmunm. yellow
lught

e \cllow ochre

e Cliun red ly/vf

WIS Alizarin crimion

et T Trangparent red
e

IRy 5. vunber

RSy R cunber

WSy /il green

R /hal bl

e Ultramarine flue

ARy /1y flack

ARTISTINSIGHT .
BE DELIBERATE

LS Gleia LGl Gl s

.purpose. What shape, colour .

Is the stroke you're trying to make? Stay,

focused and paint with intent.
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Three Master Chatee

Flaes from Ro % ‘
Co. ?ﬂﬁ%\ 0&@%/%7}
o soife and fuzgy.

Bristle frushes =
are excellent e =SS
J&wﬁﬁ}y i
paint as well as
lﬂyb}y Aewn
hin umpastrs.

An u/tﬂ:y‘ F%{’EH/}%%
& Co. Excellent for thin and th.
serokes, and very durable.

Oil painting requires a variety of brushes
| prefer Rosemary & Co. brushes, but | also recommmend Silver Grand Prix and Trekell. Hog bristle

ema

A small synthetie

_ mangouse rovid Tor ¢
nést detaling, from
. Ruemary & Co.

-‘v\

A [Wy rvory--f:__d(ferf and,
Rovid — great Tor fing
- decalt and. hard edges.

g

mMaster Chotce Filbere

ry from Rasemary & Ca.

It5 made from badger
hair and very versatile.

brushes are versatile, not terribly expensive and allow for a variety of applications. Finer-haired brushes,
both natural and synthetic, can give you an even smoother finish and make very fine detail possible.



Core skills Get started in oils

T/LM WaTden arm
ra lette frrm« New
V\/m/e Art 15 light
and well

with plenty
rom for micing. -

A re ered, glass
alette. TMJZ coimg
i a vartety of 5245,

ﬂM o cAn pue
cale

ﬂm

for r{f{rgn&e ‘

ﬂlawﬁ,

REGULAR DRAWING
IS ESSENTIAL

__fastest way to improve

and your paintings.

A seraper for rcmm /—\

pawnt from. a_glass {m lette
(ot a worder mnél

.

A aéw/amﬂe aleete from
New Wave Art, for when
e ot and. afont.

3 Choose a palette for your paint

You'll need a palette for your paint. This can be a disposable one, a clean tabletop or a handheld
wood palette, or a piece of glass that can be quickly scraped clean. Whatever you use, choose something
that's large enough to allow for easy mixing and can be used ergonomically.

n A surface to paint

The most common surfaces to
paint on are canvas, linen and wood.
You'll need to prime the surface with a
gesso or ground to prevent the acids
in the paint from contacting it directly.
Acrylic gesso is easy to use and can
be applied with a brush or roller.

A wood hardfeard /MM U c/tmf
and, smavth, and ¢asy v make

Paper from.  Raw linen before
Arﬁ/m that €5 been sized o

5 been rumgd. E)(/wmwa
swzed for ol Gt
pawneing. beantifd texenre,

and, (s strong.

=y A comfortable easel
A solid easel is important so

that your work is stable, safe and
remains at a good working height
while you're painting. You can
purchase small, metal tripod-style
easels that can be used sitting or
standing, or consider a folding wood
easel, or larger studio models that are
meant to remain in situ. g

From left tv rk(y/tf

. nexpersive, eeal, tripod-sty le
easel. €asy tv carry and mrre,
and, can be wsed, 2uither when

Jm'uy or mey

2. H-frame style easel for sendir
we. Broad frwe range and, comes
be I/ﬂ)“(/(ﬂ/tf JWZLS.

3. French-style freld easel
Lunited, carvas sizes, but (s
versatile and, porta le
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The self-taught artist

reveals how a strong

entrepreneurial streak
helped her career

Where did you grow up

and how has this

influenced your art?

I grew up in south Kansas

City, Missouri. [ went to
the somewhat blighted public schools
there; it seems like we were all pretty
poor and there was a lot of negativity.
More than anything, I think it inspired
me to lose myself in my artwork and
try to better my own situation with it.
There’s a lot of escapism within that,
especially with fantasy and surrealist art.

Is there a piece of art you saw as a child
that changed everything?

My dad had a lot of art books that he
shared with me when I was younger: the
works of Salvador Dali, Hieronymus
Bosch and MC Escher. We'd visit the
city’s Nelson-Atkins Museum of Art a lot
and my favourite piece was Penitent
Magdalene by El Greco. Every time

I went to the museum I had to see her,
my “lady with the most pretty eyes.”

I think in a lot of my paintings I still

try to capture that look on her face,

over and over again.

What was your next step in art?

I was always a little entrepreneur when it
came to my artwork. I remember trying
to sell my artwork door-to-door when I
was five. In middle school I won a bunch
of money from the National Spelling Bee
and spent it on art supplies. [ began
selling more professionally when

I opened my Strangeling.com website in
1997, while I was still in high school.

What character that you've painted do
you most identify with?

Gosh, I might have to go with Alice in
Wonderland. I see a lot of myself in her.
I like adventures, cats, reading and
exploring new things.

How much are you on the road?
An awful lot. In 2016 alone I caught
45 airline flights. Countless miles are

w Mg March 2017

o
ALICE AND SNOW WHITE

“This was created for Pop Gallery
Orlando at Disney Springs — it's
one of my most popular pieces!”

66 I remember trying to sell
my artwork door-to-door
when I was five 99

clocked up on our van. In just one year
I've been to 15 countries on four
different continents.

I have three homes: my primary house
is here in Celebration, Florida, but I still
maintain a studio near my family up in
Kansas City, and a secondary home in
London. I'm not always travelling

ABYSSAL MERMAID

“I painted this acrylic piece for
the DragonCon Art Show. It
celebrates my love of deep see
critters and bioluminescence.”

specifically for art shows, but often it's
tangentially related somehow.

What's been your best convention
experience to date?

Wow, that's a hard one. Gotta love
DragonCon. It's the one I've been doing
the longest and I have the art show every
year there. It was my first convention in
fact: my friend and fellow artist Larry
Elmore convinced me to give it a shot
-and I'm so glad I did!

What's the most important thing that
you've taught someone?
I've just come back from a teaching
position as faculty for The Fantastic
Workshop in Nashville, Tennessee with
the folks at One Fantastic Weekend,
which was fun and hopefully helpful.
More than anything though, I think
I teach people that it's indeed possible to
have a very fulfilling and lucrative life as
a professional artist.

Is your art evolving? What's the most
recent experiment you've made?

I'm an acrylic painter and I like to push
the limits with what acrylic paints can
do. Recently I've been playing with the
notion of censorship in art and have
been using a ruler to create grids of tiny
squares of paint that resemble pixellation
blurs. People first think it's done by a
computer, but it’s all done by hand with
acrylic paints. I have fun experimenting.

Do you make space in your busy
schedule to paint for pleasure?

I'm lucky in that almost all of my
painting is completely for pleasure.

I don’t do much commissioned work,
and when I do I only take on projects

I genuinely enjoy, like my work for the
Walt Disney Company. So 95 per cent of
my painting time is my own, on my own
projects for my gallery shows, and so on.

What advice would you give to your
younger self to aid you on the way?
I'd tell myself to drop out of school as
soon as I could. [ hated school. I think
I'd have been better off starting my art
career full time even earlier. That's
probably really bad advice for most
people though. Stay in school, kids.
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Between

WORLD

The next
generation of

fantasy novel 7|
is here!

Aided by the mysterious Aaron, they
are taught to survive this beautiful
yet harsh land, but there are some in
Nith with other plans for the teens

Mayberry and Marshall must learn to
control their new powers and, with
” the help of furry friends, escape their
Vj enemies and find their way home.

Misfit teens Mayberry and Marshall
wander off during a school field trip to
the Mystery Forest on a dare to find
The Wishing Tree of local legend...
and succeed. But they get more than
they bargained for when they're
swept to the alternate universe of
Nith, a world brimming with danger
and intrigue at every turn.

FREE AUGMENTED
REALITY APP!

LA
o

e l;; e Available now wherever
WOR LDb books are sold.

Find out more:

f'&g:w BETWEENWORLDSBOOK.COM




